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2：：FAQ Topics

2.1 Software #
• PowerWriter For ARM (Power Writer - For ARM)：PowerWriter For ARM

• PowerWriter For RISC-V (Power Writer - For RISC-V)：PowerWriter For RISC-V

2.2 Hot questions #
The following procedures are applicable to both the ARM series and RISC-V series
clients.

2.1.1 Old drive interference #

The common phenomenon is that the client recognizes two ports, the automatic
connection turns gray, or KEIL cannot recognize the device, indicating that the device
cannot be connected, and the driver in the device manager has an exclamation mark.

Treatment method reference:

How to handle driver exceptions

2.1.2 Unrecognized chip #

The general reason is that the line sequence connection is wrong (the reference voltage
VREF is fuzzy, resulting in a direct connection error of 5V) or the need for external power
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supply or no signature.

Treatment method reference:

• How to deal with chip connection failure

• The chip name is gray

2.1.3 Programming #

• PWLINK2 and PWLINK2 Lite support only online programming,
PW200,PW300,PW400/PWX1 Support online programming and offline programming.

• How to programming online

• How to programming offline

2.1.4 How to read the save chip data #

The premise of reading the chip is that the chip is unprotected, which can be confirmed by
reading the option byte.

How to read and save the chip data

2.1.5 Chip supported or not #

The PowerWriter website allows you to query the adapted chip model.

• Querying the chip model

• Submit the support chip form

2.1.6 Automation machine #

The signal source VCC of the machine needs to connect to the 5V pin of the writer.

https://www.powerwriter.com/index/index/chip_search.html
https://www.powerwriter.com/index/index/support_form.html


How to connect the automation machine

2.1.7 About Debugger #

While supporting MDK as a debugger,IAR directly uses an IDE based on the eclipse
framework without configuration.

• Debugger use tutorial

• Common problems of debugger

2.1.8 Correct operation of erasing #

The following information is displayed on the log page after the erasing operation is
performed: If the current page does not support erasing, see the following correct erasing
operation:
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3.1.1：：Upgrade Service
TIP

If it is used stably during the current programming process, you can skip this
upgrade or turn off the upgrade function, see Menu -> Preferences -> Check for
updates at startup.

All the software of ICWorkshop, as the product is positioned to adapt to more chips on the
market, in order to continuously optimize the user experience, it is currently updated
regularly (every two weeks), mainly including the following upgrades:

• Add Recently added adaptation chip brands or models.

• Based on user feedback, make appropriate improvements to some functions.

Each update will prompt the user to update through the form of automatic pop-up
window, and with a detailed introduction of the updated content. In addition to the
mandatory update of the main function, users can choose whether to update according to
their own use.

Client upgrade pop-up window, click the left arrow in the lower left corner, there will be a
simple explanation of this update, the right side is to allow users to skip this update, the
pop-up page is as follows:
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The following is an example of a recent upgrade record:



Firmware Upgrade pop-up window, you can skip this update by clicking No. The popup
page looks like this:



CAUTION

• The upgrade of the upper PC and firmware of the PowerWriter® is synchronized.
If the upgrade is not synchronized, an error may be reported on the new chip.

• You can also delete or change the file name update.exe in the PowerWriter®
installation folder to disable the update function. However, you will miss the
upgrade opportunity that is optimized for the function. Exercise caution when
performing this operation.
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3.1.2：：Product Selection

3.1.2.1：：Characteristic comparison #

Product
Model

PWX1 PW300 PW200 PWLINK2 PW400 PowerDebuggger

Universal
serial port

√ √ √ √ √ √

Standard
debugger

√ √ √ √ √(*Part) √

Network
debugger

x x x x x √

RTTViewer x x x x x √

RTTScope x x x x x √

ITM Trace x √ √ x x x

Online
programming

√ √ √ √ √ x

Factory mode √ √ √ x √ x
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Product
Model

PWX1 PW300 PW200 PWLINK2 PW400 PowerDebuggger

Offline
programming

√ √ √ x √ x

Multiple
projectes

√ x x x x x

Display √ x x x x x

Programming
times limit

√ √ √ x √ x

ICWKEY
authorized
signature

√ √ √ x √ x

Cloud
Platform

√ √ √ √ √ √

Bluetooth √ √ x x x √

Instruction
set

ARM/
Other

ARM ARM ARM RISC-V ARM



3.1.2.2：：Product purchase #
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3.1.3：：About Wiring
TIP

Due to different batches of devices, all devices may have different screen printing of
shell materials. Before viewing this document, determine the device model and
screen printing of shell materials.

1 PWLINK2(lite) #

Before using the device, please connect the client to view the connection diagram
between the corresponding chip and the programmer.

1.1 SWD connection type(ARM) #

• When pins 7 and 9 of the device are VDD:

Chip pin：SWCLK、SWDIO、GND、VDD and PWLINK2(Lite)'s
SWCLK(2),SWDIO(4),GND(5) ,VDD(7)Pin docking:
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• If the 7th pin of the power supply is VREF and the 9th pin is 5V: Chip pin: SWCLK,
SWDIO, GND, VDD are connected to pins of SWCLK(2), SWDIO(4), GND(5), VREF(7) of
PWLINK2(Lite). If the chip operating voltage is 5V, the chip VDD is connected to pin of
5V. Specific pin description see Hardware working state description, the device pin
distribution diagram is as follows:



1.2 SWIM connection type(STM8) #

• If your programmer’s power supply pin is 7-VDD 9-VDD: Please connect the pin SWIM
RST GND VDD of the chip in your hand with the pin 3-SWIM 1-RST 5-GND 7-VDD of
the programmer one by one. The pin distribution diagram of the programmer is
shown in the figure above.

• If your programmer's power pin is 7-VREF 9-5V: Please connect the pin SWIM RST
GND VDD of the chip in your hand with the pin 3-SWIM 1-RST 5-GND 7-VREF of the
programmer one by one. If the working voltage of the chip is 5V, connect the pin VDD
of the chip with the pin 5V. The pin distribution of the programmer is shown in the
figure above.

2 PW200 or PW300 #

Before using the device, please connect the client to view the connection diagram



between the corresponding chip and the programmer.

2.1 SWD connection type(ARM) #

• If the power pin of your programmer is 5V Vext Vext: Please connect the pin SWCLK
SWDIO GND VDD of the chip in your hand with the pin SWCLK SWDIO GND VEXT of
the programmer one by one. If the working voltage of the chip is 5V, connect the pin
VDD of the chip with the pin 5V. The physical diagram of the pin distribution of the
programmer is shown below.

•



• If the power pin of your programmer is 5V VIN VREF Please connect the pin SWCLK
SWDIO GND VDD of the chip in your hand with the pin SWCLK SWDIO GND VREF of
the programmer one by one. If the chip working voltage is 5V, connect the pin VDD of
the chip with the pin 5V. Specific pin description see Hardware working state
description, the programmer pin distribution diagram is shown below.

2.2 SWIM connection type(STM8) #

• If the power pin of your programmer is 5V VEXT VEXT Please connect the pin SWIM



RST GND VDD of the chip in your hand with the pin SWIM RST GND VEXT of the
programmer one by one. If the working voltage of the chip is 5V, connect the pin VDD
of the chip with the pin 5V. The physical picture of the pin distribution of the
programmer is shown in the figure above.

• If the power pin of your programmer is 5V VIN VREF Please connect the pin SWIM
RST GND VDD of the chip in your hand with the pin SWIM RST GND VREF of the
programmer one by one, then connect the pin VDD of the chip with the pin 5V, the
physical picture of the pin distribution of the programmer is shown in the figure
above.

3 PW400 #

Connect to the client first and query the wiring diagram of the corresponding chip model
and pW400.

The following illustration is for example GD32VF103x4:



The physical pin distribution of PW400 is shown in the figure below:



DESCRIPTION OF VDD, VEXT, VREF,5V ON THE DEVICE

• VDD,VEXT, and VREF are powered on at 3.3V by default. You can use the
PowerWriter® client to change the power.

• See How to Set the interface Level .

• The 5V pin can only stabilize the output 5V working voltage and is not controlled
by software.



4 PWX1 #

PWX1 Device interfaces are described as follows

Ports on the conversion board are as follows:



4.1 SWD connection type(ARM ) #

Connect the device to port 5, or connect the adapter board to port SWD .

4.2 SWIM connection type(STM8) #

Connect the SWIM port of the switch board.

4.3 I2C connection type(EEPROM) #

Connect the I2C port on the conversion board.



4.4 PWM connection type(wave out) #

Connect the PWM interface of the conversion board.

4.5 JTAG connection type(Debugger) #

Connect the JTAG port on the switch board.

4.6 SPI connection type(Nor flash) #

Connect the SPI interface of the switch board.

4.7 Machine connection mode #

See Interface 8.

5 External power supply wiring method #

The above programmer itself does not have a large load capacity, when the board needs
to be powered separately during programming, the wiring generally remains unchanged, if
the 5V pin of the connected programmer needs to be changed to VREF or VDD or
VEXT(based on the screen printing on the actual equipment), if it is not connected to the
5V pin, the wiring remains unchanged. In this case, you need to change the interface level
of the PowerWriter® client to an external input, and click Apply Settings to synchronize to
the programmer. As shown in the picture below:



6 Use serial port #

Please connect the pin RX, TX of the chip in your hand with the RX, TX pins of the
programmer, cross docking, power cord and ground wire one by one. The pin distribution
diagram of each programmer is shown in the figure above.
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3.1.4：：Device Status

1.0 Overview #
This chapter describes the normal or abnormal operating status of the hardware of the
PowerWriter®, the definition of the status of the indicators, and the definition and
functions of each power pin.The user can judge the working state of the equipment with
the help of this summary. If the equipment is working abnormally, the description of this
summary can judge and eliminate the anomaly.If it cannot be successfully eliminated by
yourself, please reproduce the abnormal working state of the equipment, take a video and
send it to our staff to help analyze and eliminate the anomaly.

1.1 Indicator description #

1.1.1 PWLINK2,PWLINK2 Lite #

According to the different states between the red and blue lights, the working state of the
equipment is displayed:

• Red on: normal power on, red and blue alternately, a red light is on, indicating that
the device is in standby state, at this time the chip is not recognized, no data
interaction

• Alternating red and blue flashing: After normal power-on, the working status of the
indicator indicates that the device has data interaction with the upper computer or
the target chip, and the blinking frequency represents the busy degree of data
interaction (if the data interaction reaches a certain degree, the phenomenon of
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alternating red and blue flashing will show a state of steady blue and occasional red,
which is a normal phenomenon).

• Blue steady on: After normal power-on, if the blue light of the device is steady on,
and no red/blue switch occurs, this is the abnormal working state of the device.
Consider that there is device damage or abnormal working of the main control.

• No light on: After powering on, no light on. This phenomenon means that the entire
device has no power supply. Please check the power supply status of the device or
whether the circuit components are abnormal or damaged.

• Sudden shutdown: normal power-on, or normal operation, the indicator light
(suddenly) out , considering the short circuit or the rear circuit with a large load and
other circumstances to trigger the power failure protection of the device, please pay
attention to check the short circuit or disconnect the rear circuit connected to the
device, and re-power on to see whether the device can start normally.

1.1.2 PW200,PW300,PW400,PWX1 #

• The above equipment has four indicators for only the working state of the equipment,
which are:

• Blue (excluding PWX1) : POWER indicator (POWER), normally should be on; If the
device is off or blinking, the power supply is abnormal or unstable. Ensure that the
power supply of the device is stable to ensure that the device can work properly.

• Orange (yellow) : STATUS indicator, used to indicate the status of data interaction
between the device and the upper computer or target chip. If no data is exchanged, it
is in the off state. When there is data interaction, blinking occurs, and the blinking
frequency represents the busy degree of data interaction (when a target chip is
successfully recognized by the device or a large amount of data interaction is
initiated, the blinking state may be characterized as steady on, which is a normal
phenomenon).

• Red : Operation error indicator (NG). This indicator will light up when an error occurs



during this operation. It is extinguished (cleared) after the next operation.

• Green : Operation success indicator (OK), when successfully completed an operation
or programming, the indicator light will light up, indicating that the current operation
is successful.The indicator light is extinguished (cleared) when the next operation is
initiated, or when an error occurs.

• Buzzer : (Except PWLINK system devices, other devices have buzzers.)

◦ One sound : Only when the device is powered on normally, it is used to mark the
normal startup of the device. The sound cannot be shielded.

◦ Two rings : Used to indicate that the current operation has been successfully
executed, usually accompanied by "OK" indicator light, can be set in the client
mask.

◦ Three rings : Used to indicate that the current operation has an error, usually
accompanied by the "NG" indicator light, can be set on the client screen.

◦ Long ring : The reason is that the device may detect a short circuit, pay attention
to the upper computer prompt (if connected), and pay attention to the
investigation

• TIP

The PWX1 device has a screen display, and the power supply indicator is
changed to orange, and the indicator status of the VREF pin is displayed.



1.2 Normal power-on status of the
device #

1.2.1 PWLINK2,PWLINK2 Lite #

After the device is powered on, the indicator on the fuselage turns blue and then red. The
status of the indicator depends on whether the device has data interaction Will show
different phenomena.

1.2.2 PW200,PW300,PW400,PWX1 #

After power-on, four different color indicators light up at the same time, and with the
buzzer "drop" after a sound, the blue light is on, the rest of the indicators After it is turned
off, the three indicators except the blue light will have different phenomena according to
the different working status of the equipment.

TIP

After the PWX1 device is successfully started, the device enters the system desktop.

1.3 Serial port self-test #
When you find that the serial port is not working properly, you can short-circuit the RX, TX
pins of the device, and then use a third-party serial port assistant to send any character,
and check whether any character is received after each send, and whether the character
received by the character is the same as that sent; If each sending is received and the
sending is the same as the receiving, the serial port works properly. Or else The serial port
is abnormal.



1.4 Device pin description #

1.4.1 PWLINK2,PWLINK2 Lite #

All equipment screen printing, in addition to PWLINK (a generation of products),
VDD: When pins 7 and 9 of PWLINK2 and PWLINK2 Lite are two VDD's, both VDD's output
is 3.3V by default and can be set to 5V output or external input mode on the host
computer. Examples of silk screen printing are as follows:

VREF 5V: When pins 7 and 9 of PWLINK2 and PWLINK2 Lite are VREF and 5V, the 5V pin
only outputs 5V supply voltage, which is not controlled. The operating mode of the Vref
pin can be configured by the upper computer, with 3.3V output by default, 5V output
mode by the upper computer, or an "input mode" that provides an internal



communication reference level. The communication level of sw pin is consistent with Vref.
Examples of silk screen printing are as follows:

TIP

In the above two cases, how to modify the output voltage on the upper computer,
see Interface level Setting

When the device is working normally, the Power On Reset (POR) policy is not executed,
and no data is exchanged.

SWDIO : Normal high level (generally equal to VDD), the level size is affected by the upper
computer Settings.

SWCLK : Normal low level (the above two pins may receive some special application
scenarios to adjust, at present it is like this)



1.4.2 PW200,PW300,PW400,PWX1 #

Power pin VIN: Power input, input voltage support between 2.8V~6V, internal 5V
regulated output as the working power supply of the device. The role of this pin is to
power the entire programming device (not applicable to USB to Typd-C power supply).
Therefore, if you use this pin to power the device, please ensure that the power of the
power supply is sufficient and stable. VREF(reference voltage), VEXT(extended voltage) : It
can have the upper computer configuration working state. When it is output, it can output
1.8V 3.3V 5V voltage according to the Settings of the upper computer. When it is input, it
can input 1.8V~5.5V for internal communication level reference.

When the device is in normal working state, no POR(Power On Reset) policy is executed,
and no data interaction is performed,

SWDIO : Normal high level (usually equal to VDD), the level size is affected by the host
computer Settings.

SWCLK : Normal low (the above two pins may be adjusted for special use cases, so this is
what it looks like now)

1.5 Equipment inspection method #

1.5.1 PWLINK2,PWLINK2 Lite #

When the programmer is powered on, the blue light is always on or the red light is not on,
or there is no reaction when it is powered on, it can be judged that there is a certain
hardware problem in the programmer. The user needs to recall what operations were
carried out before the equipment was abnormal (after feedback, the approximate reasons
are as follows: connected to a high-power device, to the high-power device power supply;
Voltage reverse; Wrong power line; Improper operation causes the main control to be



programmed by the surge of the USB port or electrostatic breakdown; If a device is
plugged in or unplugged during an upgrade, or if the power goes out halfway through)

When the state of the indicator light is not abnormal, the blue and red alternans will be
carried out at the moment of power on, and then the red light is always on; When the chip
is identified, the blue light is always on; When the chip is not identified, the red light is
always on. If compared with other programmer, suspected that there is a hardware
problem in the programmer, the multimeter can be used to measure the SWDIO voltage
to the ground to rule out, when the host computer does not select any chip, the voltage of
SWDIO should be consistent with the interface level set by the host computer, if not, there
is a hardware problem, the specific device problem inside the device. Specific analysis is
needed to know.

1.5.2 PW200,PW300,PW400 #

When there is an abnormal lighting condition of the indicator light in the use process, it is
necessary to consider the wiring problem, especially the connection method of VDD. The
correct wiring details should be connected to the programmer to check through the client.
If the hardware is abnormal by measuring the pin, see the above description.

(Note: When the device is powered on normally, keil does not recognize the device, or the
PowerWriter® client recognizes the two ports, this is an old firmware driver migration
problem, not a hardware exception problem, see how to handle driver exceptions)

All the above problems can be avoided by standard operation. It is recommended that
users familiarize themselves with simple hardware circuit knowledge before use.

1.5.3 PWX1 #

PWX1 equipment has a screen display. If there is a problem, most of the time, you can
eliminate it by observing the state of the equipment. If necessary, please contact the after-
sales service to return to the factory for inspection and maintenance.
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3.1.5：：Product Information
PowerWriter® series products: PWLINK2&PWLINK2 Lite, PW200/PW300, PWX1, PW400,
ICWKEY

1：：Software #
PWLINK2&PWLINK2 Lite, PW200/PW300/PWX1 same client for arm, see download
link below:

PowerWriter® For ARM

PW400 is available for RISC-V series, client download can be found below link:

PowerWriter® For RISC-V
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Security Authorization Shield ICWKEY is an auxiliary tool for PowerWriter® offline
authorization, which is responsible for controlling the number of authorization and
generating authorization keys. It requires not only PowerWriter® client, but also ICWKEY
client, see the link below:

ICWKEY

2：：Software user's manual #
PWLINK2&PWLINK2 Lite，，PW200/PW300 PW400

Apply to the same user manual, before using the product, you can have a preliminary
understanding of the PowerWriter® client of the product, FAQ is a summary of common
problems in the use process.

https://www.powerwriter.com/index/index/products.html?p=21&c=files


PowerWriter® User's Manual

PowerWriter® FAQ

ICWKEY

The user manual, related materials, SDK, and licensing videos can be found at the
following links:

ICWKEY User Development Manual
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3.1.6：：Driver Install &
Cleanup

TIP

The PowerWriter® driver is included in the PowerWriter® software installation
directory. It is recommended to use the PowerWriter® client software for processing.

1：：Download and Install #

1.1：：Standard driver (support winusb) #

Attachment：：

PowerWriter® latest driver download (suitable for PWLINK2(including lite), PWX1,
PW200(PW300)) Arm chip version

CAUTION

✓
Connect the device to the USB interface of the Windows host: If the device is not

inserted, the driver installation may fail.

✓
After installation, you may need to restart the system if prompted.

✓
This driver works with firmware versions greater than 1.00.82(Without PWX1).
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1.2：：SHA1 Support Driver (windows 7) #

If the PowerWriter® device attribute in device management indicates that it is not signed,
so it cannot connect, please try to update the system patch, or use the following alternate
driver. The error screenshot is shown below



Attachment：：

Old Windows 7 Dual Signature driver (used when the Device Manager properties bar
indicates no digital signature)

1.3：：Latest RISC-V drivers installed #

Attachment：：

http://localhost:3000/en/assets/files/PowerWriter_driver_win7_sha1_signature-72085d3e6ed30938d1cd48101698c0d3.zip
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PowerWriter® For RISC-V Driver Installation (for PW400 RISC-V chip version)

INSTRUCTIONS FOR USING RISC-V DRIVERS

• PW400 driver is dual serial port driver, compared with Arm series driver, no HID,
no Winusb

• PW400 USB ID is not the same, can not use PW200, PW300 driver.

• ARM series and RISC-V series have the same way of driver installation and
distribution. It is recommended to use PowerWriter® client software for
processing (menu bar -> Help -> Driver Installation).

2：：Old firmware driver migration #
Firmware version 1.00.80 and below USB driver , if you install with the latest version of
the driver, it will not work after installation, please install the old firmware driver first, after
connecting the device, upgrade the firmware, switch to the new firmware, download the
address, and then reinstall the new driver.

Download the old firmware driver

2.1:Handling for old and new firmware #

After upgrading the old firmware to the latest firmware, the device manager may see a
device with an exclamation mark #PW_HID_CMSIS-DAPal Port (Interface 0) or
PowerWriter® Serial Port (COM19), And the debugger channel is not working properly
because of the old driver interference, which can be handled as follows

http://localhost:3000/en/assets/files/PowerWriter_For_RISC-V_driver-36c733827611e4e5d7367fbe3e8e8129.zip
http://localhost:3000/en/assets/files/old_firmware_driver_for_arm-45afbaf5abf716769f823eaebae06ee0.zip


2.1.1 Manual cleanup #

✓
Step 1: Display the exclamation point on the device, right mouse button, uninstall the

driver, and check Remove Driver

✓
Step 2: After the uninstallation is complete, refresh the device again and wait for the

driver to be installed

✓
Supplementary: If exclamation marks still appear, REPEAT STEPS 1 and 2 until the old

driver is uninstalled.

The operation demonstration is shown in the figure:



2.1.2 Auto clean #

PowerWriter® Driver Cleanup Tool (ARM products supported)

CAUTION

✓
This tool will clean up all versions of the PowerWriter® driver for the system to

solve the problem of exclamation marks after upgrading to a new firmware.

✓
Windows 10 + system after cleaning, still for free drive, no need to install

additional driver!

✓
For Windows 7 SP1, install the latest driver (including WinUSB driver) from the

http://localhost:3000/en/assets/files/PowerWriter_driver_clean-33638756c0a5f8b984332966e07c50cb.zip


client software. Please note that the minimum system requirement is Windows 7 SP1.

✓
If the automatic clean-up fails, refer to Manual clean-up method

3：：Common exclusion Methods #

3.1 Driver is normal, but cannot connect #

If the driver is newly installed, you can try to restart the system, after the driver installation
may need to restart. Second, the device manager device driver is normal, but still can not
connect, you can also try to restart the system.

3.2 Rebooting system fails to connect #

If you still cannot connect to the device after rebooting the system, please first try to clean
up unused port numbers and drivers, as shown in the following ,After cleaning up the
redundant information, it looks like this,Try connecting to the device again.





3.3 Try changing the port number #

TIP

Change the port number, the system will re-initialize the driver, also can solve some
driver exception issues.
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3.1.7：：Debugger Tutorials

1. IDE Support #
✓

IAR，Any version, CMSIS-DAP V1 interface

✓
IAR，>=7.40.2，CMSIS-DAP V2 interface

✓
Keil，Any version，CMSIS-DAP V1 interface

✓
Keil，>=5.36，CMSIS-DAP V2 interface

✓
Segger Embedded Studio，CMSIS-DAP V1 interface

✓
Segger J-Flash，==V7.22B，CMSIS-DAP V1 interface

✓
OpenOCD

✓
PyOCD

✓
Probe RS

✓
FreeMASTER，CMSIS-DAP V1 interface

✓
RT-Thread Studio

✓
Others to be added

2. Common IDE Setup Methods #

2.1 MDK Debug Settings #

Follow the procedure below to open Project Settings and select CMSIS-DAP Debugger as
shown in the following figure:
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Adjust the basic settings of the debugger according to the following settings, and check
whether the target chip is connected normally, as shown in the following figure, after no
problem, go to the next step.



Flash Download settings are as follows, according to the actual project requirements, set
the appropriate erase method, as well as Program, Verify, Reset and Run options, and add
the current chip's flash algorithm, as follows:



TIP

• Erase Method Selection: If you need to keep some data of the chip, such as
setting data, signature information, you usually select the erase method as
Sector Sections.

• Reset and Run: To perform a reset and run after the current firmware, you need
to check the Reset and Run option.

For advanced users, custom debugging settings can be adjusted as needed, as shown
below:



Check the Use Debug Driver option to enable the hardware debugger, this option is
turned on by default, if you encounter problems, this option is also a key setting to check,
as follows:



After checking the settings, you can enter the commissioning normally.



2.1.1 Operational Demonstration #



2.1.2 Video Demonstration #

2.2 IAR Debugging Settings #

Right click on the item, enter Options setting, switch to General Options standard setting
page, and check whether Target -> Device is selected correctly, as shown below.



Enter into the Debugger menu, Setup tab page, select Driver as: CMSIS-DAP device, you
can check the Run to main option as needed, as shown below.



In the Interface tab of Debugger -> CMSIS-DAP, select the interface as SWD as follows：

After the above setup you can proceed with the debugging and development of the chip.

2.1.1 Demo Video #



2.3 RT-thread Studio Debugging Settings #

RT - thread Studio Download Address:https://www.rt-thread.org/studio.html

Go to SDK Manager , as shown below:

Check if the current chip support package, RT-thread source code, and PYOCD are
installed.

https://www.rt-thread.org/studio.html


TIP

To debug a project through DAPLink, you must use Pyocd or OpenOCD as the
debugger's Adapter, and eventually debug through the gdb connection.

Create a new RT-Thread project as shown below:

Set up the debugger as follows:



Once the configuration is complete, the project is generated and ready for download and



debugging as follows:

TIP

It is necessary to have Pyocd or Openocd installed in the SDK-manager.

2.4 Other IDE Tutorials #



3. Frequently Asked Questions #

3.1 Target Chip Mismatch #

Common errors are described below:

• Connection refused due to device mismatch!(Not a genuine ST Device! Abort
connection).

• PDSC : Sequence Execution failed.

The above problem may be due to purchasing a chip that is not the original chip, see
Target chip mismatch

3.2 Connected device (chip) failure #

• No Debug Unit Device found

• SWD/JTAG Communication Failure

• RDDI-DAP ERROR

Details of the above issues can be found in Communication Issues

3.3 Programming Failure #

• Flash Timeout. Reset the Target and try it again.

• Error : Flash Download failed - "Cortex-M4"

• Could not stop Cortex-M device!Please check the JTAG cable.

• Error : Flash Download failed - Target DLL has been cancelled

Details of the above problem can be found in Programming Failure



3.4 Verify failure #

• Contents mismatch at: 08000064H(Flash=FFH Required=0)

Details of the above issue can be found in Checksum Failure

3.5 Flash configuration error #

• Cannot Load Flash Programming Algorithm!

• Overlapping of Algorithms at Address 08000000H

For details of the above issues, please see Flash configuration 1, Flash configuration 1.
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3.1.8：：Debugger FAQ

1 MDK autorun not working #
After the program is downloaded and found not running, the following points need to be
noted:

• Check that the reset mode in the Debugger settings is correct.

• Reset and run is checked or unchecked.

• Is the Flash Algorithm setting correct.

2 Breakpoints do not take effect #
Please check the compilation settings. Such as optimization level, debugger settings, and
its own code features such as whether watchdog is enabled.

3 Limit the number of breakpoints #
The number of hardware breakpoints is related to the chip itself and depends on the MCU
core version unit, the manual will list the number of breakpoints supported by the current
chip, please check the manual of the chip you are using for the contents of the debugging
chapter.
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4 Bootloader deleted during download #
• For IROM setup, it is important to make sure that the generated Image address is

correct.

• When writing to Flash, pay attention to the selection, page erase, set in the Debugger
page, so that you can avoid the whole chip erase, retaining the other data inside the
chip.

5 Prompt for device mismatch #
Tip Message: Connection refused due to device mismatch!(Not a genuine ST Device!
Abort connection)



Maybe the purchased chip is not the original chip, such as polished silkscreen, or business
false advertising, due to some of the popular chips many manufacturers have similar chips,
and even PIN TO PIN compatible, so there are these problems, the low version of the MDK
and the chip support packages will not check the chip's IDCODE, so there may not be an
error report, replace with a higher version of the MDK and the support packages, there
may be an error report! If you change to a higher version of the MDK and support
package, you may get an error. You can check the IDCODE of the chip manual to
determine the real chip model.

For example, the IDCODE of the STM32F1 chip is: 0x1B10417.



But the sample is: 0x2BA01477 as shown below:

After identifying, this chip may be: CS32F103C8T6 (CKS32F103C8T6).

5.1 Solution 1 #

According to IDCODE, you can find the real model number of the chip, download the
backup package of the corresponding manufacturer's chip, install it, switch it to the actual
chip model, and then debug it.



CKS32F103C8 Download (Keil.CS32F1xx_DFP.pack is required, STM32F103 library
and CKS32F103 library can be used to run the demo properly.)

5.1 Solution 2 #

First find the pack of the selected chip, and find the pdsc file of the current chip, such as
C:\Keil_v5.25\ARM\PACK\Keil\STM32F1xx_DFP\2.3.0\Keil.STM32F1xx_DFP.pdsc

<sequence name="CheckID">

<block>

__var pidr1 = 0;

__var pidr2 = 0;

__var jep106id = 0;

__var ROMTableBase = 0;

__ap = 0;      // AHB-AP

ROMTableBase = ReadAP(0xF8) & ~0x3;

pidr1 = Read32(ROMTableBase + 0x0FE4);

pidr2 = Read32(ROMTableBase + 0x0FE8);

jep106id = ((pidr2 & 0x7) << 4 ) | ((pidr1 >> 4) & 0xF);

</block>

//Comment out the chip ID to check the configuration

//<control if="jep106id != 0x20">

// <block>

//          Query(0, "Not a genuine ST Device! Abort

connection", 1);

//          Message(2, "Not a genuine ST Device! Abort

connection.");

// </block>

//</control>

</sequence>

http://localhost:3000/en/assets/files/cks32f103_demo-9d60658a2c7dc7d96d8137d9ebe99ad0.zip
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TIP

• The PowerWriter® team does not trace back to the actual chip model, and the
above chip IDCODE is only illustrative of actual cases, as noted.

• The pdsc file is just an example, the paths and settings may be different for
different versions of packages.

6 Unable to recognize debugger #
Error Code: No Debug Unit Device found.

Handling method: Reconnect the programmer, make sure the programmer is connected
properly and the driver is connected properly, refer to Driver Installation and Cleanup。



7 RDDI-DAP Error #
Error message: SWD/JTAG Communication Failure(RDDI-DAP Error)、RDDI-DAP
Error。



Solution:

Make sure the programmer and the chip programmer port are connected properly, the
chip does not have advanced protection turned on or the programmer port is multiplexed,
please check the specific treatment:

How to deal with a chip that is not connected

8 Programming Failure #
Error message: Flash Timeout. Reset the Target and try it again.



Solution:

• Ensure that the chip does not have read protection and write protection turned on,
remove the protection method reference:De-read protection。

• When the program runs on the fly or the chip reset is not successful, it will lead to
unsuccessful programming, please reconnect the chip and make sure that the
debugger setting options are as shown in the following figure, and you can try to pull
the boot0 pin high before debugging.

• Change the debug clock size.

• Use the PowerWriter® client to erase the target chip.



9 Verify failure #
Error message: Contents mismatch

Troubleshooting: Make sure the flash algorithm parameters are normal, or you can re-
select the chip model to update the flash algorithm settings.





10 Unable to load flash Algorithm #
Error Code: Cannot Load Flash Programming Algorithm

Reselecting the Flash Algorithm



11 Repeat add flash algorithm #
Error Code: Overlapping of Algorithms at Address 08000000H

Check Flash Algorithm Settings.

12 Disconnection during debugging #

As shown in the above figure, MDK erase, write, and checksum all pass, but after the
Application running ... However, after the Application running ..., RDDI-DAP Error occurs!



Reason: The debugging function of IO is not turned on in the program, for example, the
debugging function is off by default in Cube MX, if you generate the code directly to
debug, this problem will occur.

Solution: In Cube MX, on the left side, open Serial Wire in SYS->Debug as shown below,
and then update the code.

If directly in code, adjust the debug mode.



TIP

Other brands and tools are handled similarly, and such problems are caused by the
debug pins not being configured in debug mode.

13 MDK cannot recognize the chip #
The reason for this phenomenon is the same as the previous one, because there is code
running in the chip, the debugging port is disabled, and the efficiency of the
PowerWriter® response is faster than the debugger, so there is a situation where the
PowerWriter® can recognize it, but the MDK fails.

Treatment:

After connecting to the target chip using the PowerWriter®, perform the following to



erase all data.

✓
Option byte, restore the defaults, and then write.

✓
Erase Program Memory Program space data.

After performing the above operations, go to the MDK to debug.

14 Watch variable not refreshed (grayed
out) #
The data is not refreshed because Periodic Window Update is not checked. After entering
the debugging state, check this function from View -> Periodic Window Update in the
menu, the debugger and the data in the Watch window will be refreshed in real time, as
shown in the following figure:



The reason for the grey is that the compiler optimization level is too high, resulting in the
actual generation of debugging information and source code breakpoints are not
completely consistent with the location of the synchronization problem, at this time you
can adjust the optimization level of the entire project, such as to change to the level of 0
no optimization, the location of the source code breakpoints and access to the actual
variables are completely consistent with the following chart:



In addition, you can adjust the optimization level of part of the source code individually by
right clicking the source code file (.c, .cpp) in MDK to open the file properties and set the
optimization level of the file individually, as shown in the following figure:
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3.1.9：：Add Firmware
Method
In the PowerWriter® software:

• Select Chip.

• In "Program Memory", "Add Firmware" and "Apply Firmware".

• Click Full Function Auto programming.

• After the programming test is normal, you can save this project, and next time you
can re-open it to programming directly.

1：：Prepare #

04/12-15:56:46:906> Update programmer Settings complete...

04/12-15:56:46:935> Update chip information successfully...

04/12-15:56:49:447> Target Online...
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2：：Operational Demonstration #

3：：Multi-zone firmware #
The file belongs to the multi-segment firmware, this situation is normal, need to be added,
multi-segment firmware, the first section on-demand loading, because: developers in the
project using the definition of the section, or sct file, the definition of the segment
information, the PowerWriter® will automatically recognize the inside of the Segment
(section information) Due to this segmentation of the firmware, the inside of the section,
there will be Because of this kind of segmented firmware, there will be dummy byte



(padding byte, default is 0xff), PowerWriter® will remove the default padding when
loading, and only take out the effective length of the firmware (this can speed up the
programming speed, avoid writing dummy byte when programming), and other blocks
such as boot code, vector table, bootloader code, application/user data/option byte, etc.
to show the user which blocks need to be loaded to programming, the user can choose
according to the need, or load multiple times.

TIP

Segmented firmware can be added at once using the merge function. PowerWriter®
will merge all segments by default, but please note that if the firmware contains
segments that exceed the Flash space, it will indicate that the capacity is exceeded
and cannot be added.
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3.1.10：：Error when add
firmware
When you are adding firmware, the following error may be reported:

Firmware can not exceed the Program Memory space, including the start address and end
address must be within the range of Program Memory. When the above error occurs,
check whether the capacity of your own chip is selected correctly, if the chip model is
correct, then consider checking the firmware size or compilation settings; if you encounter
the case of hex file firmware segmentation, you can try to cancel the merge add function
of the firmware, and add the segmentation to write once.

The above prompt appears because the compiled firmware address and the chip's FLASH
address does not match, when importing bin format file, this format does not have
address information, the default is 0, then the software will prompt the lack of address
information or the address is not correct, whether to load to the specified address,If you
pass the Add Firmware methodologies,The program will confirm more information to you,
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including the size, checksum value and starting address.
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3.1.11：：Smart
Programming
PowerWriter® provides a wealth of online and offline programming features:

• Supports continuous programming

• Supports chunked programming

• Supports option byte programming

• Other functions, etc.

1：：online mode #
Automatic download of all data can be achieved through full-featured auto-programming:

• Menu Position: Execution->Full Function Auto Programming.

• Toolbar buttons
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3.1.12：：Fast Offlining
This document demonstrates the configuration process for rapid offline production after
receiving the PowerWriter® from 0. The reference chip is the N32G032P6W7 from
Nations, and the process is the same for other chips, so we will describe how the whole
process works.

1：：Prepare #
Before configuring the PowerWriter® offline production project, you need to prepare the
PowerWriter® client software, the firmware data to be programmed, and know the pins
and configuration methods of the signal interface of the PowerWriter® programmer, as
well as some of the special functions of the process.

1.1 Installing the PowerWriter® Software #

PowerWriter® software can be obtained through the following site, and then install the
client software, the software is completed to start the software, PowerWriter® supports
Win7 or above system.

PowerWriter® Download
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Note: If there is no network in your environment, you can contact our customer
service to get the installation package, the installation package in both places are the
same installation package.

After downloading the installation package, unzip the zip package, run
PowerWriter_x.x.x.x.x_installer.exe to install the PowerWriter® client software, start the
software after the installation is complete, and enter the PowerWriter® main interface, as
shown in the following figure:



1.2 Select Target Chip #

Take N32G032P6W7 as an example, select N32G032 in the Select Chip button.



1.3 Confirmation of target chip connection #

On the far right side of the PowerWriter® software toolbar there is a way to view the Chip
Connection Diagram, as shown below:



Or look through the menu:

You can see the signal wiring diagram of PowerWriter® as shown below, you only need to
connect VEXT, GND, DIO, CLK, NRST and BOOT0 are auxiliary signals, such as
programming normal, can not be connected.



The interface signals of the PowerWriter® are shown as the socket pin in the above figure,
and can also be viewed via the Menu -> Tools -> View PowerWriter® Interface Definition
button.



Referring to the information as above, connect the target board and chip to confirm the
connection method, at the same time the PowerWriter® software indicates that the target
chip is connected, as shown below:

2：：Basic parameters #

2.1 Erase Method #

The default is full erase, full erase will erase the entire chip data, and then write, if the

04/12-17:06:39:645> Update programmer Settings complete...

04/12-17:06:39:676> Update chip information successfully...

04/12-17:06:41:933> Target Online...



firmware is larger than more than half of the chip capacity, full erase efficiency will be
guaranteed, if the firmware is smaller, you can choose the page erase, only erase the need
to erase the sector, according to the actual application of the choice of full erase or page
erase, such as no special requirements, the default can be.

2.2 interface VREF #

The default interface level is 3.3V, which matches the IO voltage of the target chip, just
match it according to the IO level of the actual chip.

2.3 Programming speed #

Default is 10Mhz, if the working environment has less interference and the external wiring
is shorter (less interference), then it can be changed to 20Mhz, if there is a failure during
the programming process, then you need to change it back to 10Mhz, or reduce the
speed.

Note: Unless the chip itself is defective, a chip that fails to programming in can be re-
programmed and will not lead to chip scrapping.

2.4 Option byte update method #

The default is Before programming: factory setting (for chips with secondary
programming), After programming: write user-defined option words, which can be
adjusted according to the actual situation or not.



3：：Offline programming Behavior
Settings #

3.1 Auto start/stop programming #

Turn on the automatic chip detection function, you can start the programming without
pressing the key during the offline programming (you need to start it for the first time),
and it will start the offline programming automatically when connecting to the target chip,
as shown in the following figure:

3.2 Limit the count of offline programming #

If you need to limit the number of offline programming times, please enable the function
of limiting the number of programming times and limit the number of times as shown
below：



4：：Option Byte Configuration #
If you need to programming special option words after programming the firmware, such
as read protection to prevent the chip from being read out, set RDP1 and RDP2, and set
RDP1 to RDP2, and set RDP2 to RDP2.

As above set to level 1 protection, if you need to completely disable debugger access after
programming, you can set RDP2 to L2 as shown below:

CAUTION

If L2 is set, the target chip cannot be connected to the debugger (programmer) after
programming is completed.



5：：Importing firmware data #
After the basic setup is completed, you can import the project's firmware data into the
PowerWriter®, through the Add Firmware button in the Program Memory page, import
the firmware in intel Hex, Raw binary , srec record (s19) format file, after importing, a
confirmation box will pop up as shown below, after confirming that there is no error, click
on the OK.

NOTE

GCC compiler compiled firmware may pop up firmware selection box (prompting the
loaded file has more than one firmware), which is related to the compiler's firmware
output form, arm complier output file default padding 0xff, GCC is segmented output
valid data segments, if there is more than one segment of the firmware, generally
choose to merge the add can be added, if the add fails to prompt beyond the space,
generally in the compilation of the project, set the address beyond the Flash space,
such as compiling memory code, but did not deal with, or in the project, the option
byte is also compiled into, there will be such a prompt, such as not sure how to deal
with, please contact us for technical support.



6：：Importing a project to programmer #
After everything is ready, you need to import the project into PowerWriter®, you can do it
through the menu Execute Offline Load, or the toolbar shortcut buttons, Note: When
loading the project offline, if the current data has not been saved as a project file, you will
see the message of whether or not you need to save it. Project offline loading read
adjustment

When you save the project, set the save path of the project to avoid the loss of the
configured programming data, and you can also set a password for the project for data
protection to avoid data theft by others.



TIP

After the project is configured, it can be reused subsequently without having to
reconfigure it each time, just load it into the programmer to deliver it to the
production line, and if you need to update the data, recycle it back from the
production line and reload the new data into the programmer.



6.1 Operational Demonstration #

7：：Delivery programmer to the
production line #
After the programmer is configured with data, the programmer can be delivered to the
production line for production.



8：：Confirmation of programming
results #
programming results, given in three ways:

• Two beeps from the buzzer means success. More than two sounds means failure. If
the comparison production line requires no ringing (noisy), the buzzer can be turned
off when configuring the basic parameters.

• Green light indicates success, red light indicates failure.

• Interface signals: OK output is high to indicate successful programming, NG output
is high to indicate programming failure, you can use the signals from these two pins
to access the automation control system.



9：：Common problems #

9.1：：Auto-detect is on, but it doesn't respond when you
put the chip in. #

The PowerWriter® requires a manual button press to start the automated process for the
first time to ensure that the production environment is ready and to avoid incorrect
programming when the production line is not ready.

9.2：：Auto-programming function is automatically
turned off when programming fails #

If you use the programming test rack, press the way, the failure of the case is very low,
only in the manual use of tweezers to pick up the bare core due to the lack of alignment
or poor contact may lead to failure, this case can be adjusted to increase the de-jittering
time of the automatic detection.

After the automatic programming function is turned off, it is usually necessary to manually
verify the production environment, and after the verification is complete, press the button
again to resume the automatic detection of the chip programming process.

9.3：：Failure error when problematic backtracking #

PowerWriter® products for sale do not have a screen, but they do record the last error
code, which can be read by the PowerWriter® software to obtain the type and description
of the error.



TIP

For occasional programming failures, try to lift the programming test rack and press
it again. If the same board (chip) fails more than 2 times, it will be sorted out, if
necessary, please contact us.

9.4：：programming state back and data back #

Projects that have been loaded into PowerWriter® can be read internally by going to
Menu -> Perform Offline Read and Save, (if a password has been previously set, a
password is required to view the data).

Or backtrack the current programming status, such as the number of programmings
remaining, by doing the following

9.5：：programmer Marker #

The programmer can be marked by menu Tools -> Reserved Data Read/Write, as shown
below:



9.6：：Tagging PowerWriter® Projects #

You can make a note of the project in the menu Tools -> Advanced Settings for Offline
Production Projects -> Offline Files, as shown below:



10：：Contact & Feedback #
If you encounter any problems, suggestions or comments in the process of use, promptly
contact us.
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3：FAQ Contents 3.1：Common 3.1.13：How to setup RDP

Version: Next

3.1.13：：How to setup RDP
PowerWriter® provides a complete option byte description page for each chip, refer to
the "Option Bytes" Tab page as shown below:

TIP

The option byte description page is basically the same as the chip datasheet, for
some brands we have extended the official option byte to realize specific functions,
please refer to the option description.
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3：FAQ Contents 3.1：Common 3.1.14：How to remove RDP

Version: Next

3.1.14：：How to remove
RDP

1：：Disconnect while reading data #
When PowerWriter® connects to the target chip successfully and can also read OB
correctly, but when reading other data, it reports an error, and in serious cases, there is a
prompt that the chip is offline, the possible reason is that the target chip has a read-
protection, and the method to release the read-protection is as follows.

2：：Setting option bytes #
After connecting the chip, switch to the Option Byte page, and then restore the option
word to default, or modify the read protection method to none, as shown in the figure.
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3：：Write option byte #
After turning off the read protection in the option byte, you need to write the option byte
to the chip to remove the read protection, as follows:



4：：Operational Demonstration #

CAUTION

Unprotected, updating the option byte causes the target chip to initiate an internal
erase operation, and depending on the security characteristics of the chip, the
original data inside will be lost.



5：：Unlock chip when SWD is off #
Some chip models in the programming, and the mainstream chip there are some
differences, when the chip's option byte is set to the first level of protection or the second
level of protection, the chip will automatically turn off the SWD after programming, at this
time the specific unlocking mode refer to the CX32 unlocking mode, the chip will
automatically turn off the SWD after programming.

See CX32 unlocking method.
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3.1.15：：Chip Connection
Failure

1：：Troubleshooting wire problems #
Use a multimeter to self-test that the DuPont wire used is conducting.

• Connect the red and black pens correctly.

• Connect the red and black pens to the ends of the wires to be measured.

• If the resistance is close to zero, or relatively small, the wire is connected, and if the
resistance is high the wire is disconnected.

TIP

If, after the above operation, you determine that there is a problem with the cable,
you will need to replace the cable before proceeding with the operation.

2：：Troubleshooting Hardware Issues #
• First, open the corresponding datasheet of the chip to find the corresponding power

supply pins and programming ports of the chip, and then make sure that the
hardware is soldered properly and then connect the chip to the power supply.

• Without connecting the programming ports, such as SWDIO and SWDCLK, measure
the voltage of SWDIO with a multimeter.
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• If the chip is empty or there is no multiplexed SWDIO pin, the SWDIO pin has the
same voltage as the power supply of the chip, if not, there is a hardware abnormality,
please check the hardware.

Example references:

3：：Troubleshooting programmer wiring
problems #

• Open the PowerWriter® software and select the appropriate model number based on
the chip model and view the appropriate connection diagram.

• Click on the Tools button in the menu bar to view the interface definition for the
corresponding programmer.



• Prioritize the use of the connection cable provided with the programmer and ensure a
stable connection.

• Ensure that the corresponding power supply and programming port are connected
properly. If they are connected properly, the software log will show that the target
chip is connected.

• For wiring details and description of the programmer pinout see About Wiring。

•





4：：IO multiplexing pins #
• When the program running on the chip has multiplexed pins, it is recommended to

use only the programmer's power connector when connecting.

• When using an external power supply, connect the reset pins.

• When the chip is multiplexed, compilers such as KEIL may not be able to connect to
the chip, so you need to use PowerWriter® software to erase the chip before
debugging.

• When multiplexing the chip's programming pins in a program, it is recommended to
add a delay of about 2~20ms before them.



5：：Troubleshooting chip damage #
• Replace the chip with a new one.

• Replace the PCB with a new one.

• Replace with another chip model.

6：：Try to adjust the clock speed #
In different environments, the clock speed of the PowerWriter® programmer mode is
higher than that of the Debugger mode. For example, in the MDK system environment, the
default clock speed is 1Mhz, and the default clock speed of the PowerWriter® is 10Mhz,
so there may be a situation in which the MDK is able to connect to the target chip but the
PowerWriter® fails to do so. There may be cases where the MDK can connect to the target
chip, but the PowerWriter® connection fails. You can try to reduce the clock speed to, for
example, 5Mhz, etc. In some applications, the MCU firmware has enabled read protection,
so you need to connect to the target chip with a faster speed, and you need to adjust the
clock speed to a higher speed, or else you may have a handshake failure (the system
enters into the protection state, and the debugging port is turned off). settings to the
PowerWriter® device, as shown below:
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3：FAQ Contents 3.1：Common 3.1.16：VREF Config
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3.1.16：：VREF Config
Interface voltage Setting (VREF) is used to set the output voltage of the programmer and
the level size of the programmer signal, which generally defaults to 3.3v on power-up, and
can be changed by connecting to the PowerWriter® upstream software, refer to the
following:

TIP

When an external voltage is selected, the target board should be connected to the
programmer's power pins and ground along with the external power supply, as it is
necessary to use the external input power to power the programmer interface.

Modify the default output voltage when the programmer is powered on, you need to
check Save Global Save Voltage:
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TIP

• When the default output voltage is to be re-modified, the settings need to be
updated again once more.



• If you need to turn off this action for different application scenarios, please
change the setting to external power input and do not use the power supply of
the device itself to control it, as shown below:

ABOUT OUTPUTS VERF(VEXT) OUTPUT JUMPS

VREF (Reference Voltage), VEXT (Extended Voltage) may jump when the chip is
not successfully connected, this action is actually trying to execute POR (Power On
Reset), which is used to solve the problem of connecting and unlocking when the
target chip is in the following two situations:

• Target chip open protection: After some chips open protection again, the
RESET pin may not be able to perform reset and can only be reset by POR, at this
time, it is necessary to perform POR to communicate with the target chip.

• Target chip internal firmware disables debug port, or multiplexes RESET
pin: Some chips run internal firmware that multiplexes the debug port IO, or
multiplexes the RESET pin, which may also result in not being able to reset the
target chip, and only attempting a POR reset.

Note: Self-output power supply can do POR, external input voltage can't do POR;
however, if self-power supply exists on the board, it also can't do POR, the power
supply must be controlled by PWLINK.
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Version: Next

3.1.17：：Chip name turns
gray

1：：Vendor Signature Overview #
When PWLINK2 Lite products are manufactured, several brands are signed by default, and
other unsigned brands are not available by default. If you need to switch brands, series, or
models supported by the PWLINK2 Lite version, you need to select the user in the
platform and then synchronize the settings in order to use the new brand:
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INFO

• PWLINK2 Lite and PWLINK2 hardware are identical.

• PWLINK2 supports all existing brands as well as future adapted brands. Lite can
only use a few brands at the same time, if you need to use other brands, you



need to switch yourself.

• PWLINK2 Lite can manually change supported brands by itself.

2：：Configure vendor signatures online #

2.1：：Online Self-Configuration #

Online self-configuration function, by clicking on the chip selection interface in the lower
left corner of the "chip manufacturer's signature", hyperlink to enter the boot
configuration page, as shown in the following figure:



Click "Open Online Configuration Page" to go to the platform server side as shown below:

According to the list of brands displayed, select the brand you need to use by yourself as
needed, and confirm when the selection is complete.

CAUTION

• If you don't have an account with Creative Core Workshop, please register for an
account and log in to the vendor signature configuration page.

• If you are not connected to the device, the client will not show the
synchronization entry and you need to use offline configuration.



2.2：：Online Self-Service Synchronization #

After completing the manufacturer's configuration on the platform side, you need to
synchronize the information to the PWLINK2 Lite device and synchronize the
manufacturer's signature information in the PowerWriter® client, as shown below:

Wait for the operation to complete and then OK to synchronize the vendor signature to
the chip.



3：：Offline configuration of vendor
signatures #
If the PWLINK2 Lite hardware device is no longer around, or if there is no network in the
current environment, this means that the online synchronization function cannot be used,
in which case the offline vendor signature can be used.

3.1：：Copy the device's SN #

To generate signature information offline, you need to bind it to the SN of the current
device, please connect the device first, read the SN information of the device, and copy the
SN information to the clipboard.

3.2：：Online signature generation #

Configure the page online using a web-enabled device such as a cell phone. Tool
Configuration (icworkshop.com) (https://www.icworkshop.com/user/
supportChipConfiguration)

https://www.icworkshop.com/user/supportChipConfiguration
https://www.icworkshop.com/user/supportChipConfiguration
https://www.icworkshop.com/user/supportChipConfiguration
https://www.icworkshop.com/user/supportChipConfiguration


Fill in the SN of the device, and then query the device to get the device information as
shown below:



When ready, execute the modification:



After the operation is successful, copy the signature information:

At PowerWriter® Vendor Signature, paste the signature code, then write to the device and
OK as shown below:



4：：Automatic synchronization of
settings #
Vendor signature will not be automatically synchronized by default, if you need to
synchronize the vendor signature automatically, please check this function in Settings-
>Preferences->Automatic Synchronization of Vendor Signature, every time you select the
chip, the vendor signature information will be automatically synchronized from the
platform side, as shown in the following figure:



5：：Operational Demonstration #
This demonstration is to add the Air branded series:



CAUTION

Automatic synchronization of signatures may cause lag in system environments with
poor network environments, so it is recommended to keep the default off and
manually configure or synchronize when needed.
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3.1.18：：Offline auto start/
stop
When you make the pkg file for offline programming, check Auto Chip Detection in
Quantity and Self-Detection page, after loading the offline data (click the shortcut key
above to load, or load offline in the menu bar Execute), you need to keep the offline state
and manually press the key to programming and start the function of auto chip detection.
Note: Even if automatic chip detection is enabled, you still need to manually press the key
to start the programming process for the first time during the programming process.
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3.1.19：：Online Failure

1：：Impunity #
Descriptive: Error Write Flash Address The target write flash failed。

2：：Handling #
• Not erased before programming (programming): Please erase the chip first and

retry.

• The chip is (write) protected: Please set the option byte to default, and then
perform a reset after writing the default option word.
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• Other reasons: Occasional reasons such as unstable communication, you can try to
replace the cable and retry, if you can not identify the cause by yourself, please
contact technical support and submit detailed information for processing.
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3.1.20：：Failed W/R Option
Byte

1：：Error message #
During the process of reading and writing the Option Byte (OB) to the target chip, the
following read/write errors may occur, as shown in the figure below:
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2：：Possible causes #
• Discrepancy between the actual chip and the target chip: Each model may have a

different memory layout structure (memory map), which may result in undefined
behavior if reading or writing in the wrong way. If you read or write in the wrong way,
it may lead to undefined behavior and cause errors, please make sure the chip is the
currently selected chip. -Please make sure the chip is the currently selected chip.

• Wiring is unstable: Replace wire, 'Re-plug and retry.

• Other reasons: Please provide feedback to our technical support.
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3：FAQ Contents 3.1：Common 3.1.21：USB not recognized
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3.1.21：：USB not recognized

1：：Error message #
When the device is connected to USB, it prompts for unrecognized USB devices. As shown
in the figure below:

2：：Causes and solutions #
• If you are using a cable that has only a power supply function but no communication

function, you can replace the USB cable or use the USB cable that comes with the
device.

• Using the host front USB interface, the front USB interface is wired from the
motherboard to the chassis, the quality of the chassis on the market varies greatly, the
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USB interface aging and other circumstances that lead to USB communication
instability, this time you can connect the device to the host rear USB interface to try.

• If you are using a poor quality HUB extension cable or if you are using an extension
cable that is too long and the communication is unstable, you can replace it with a
high quality HUB or use the rear USB port.

• Damage to the device itself can be determined by observing the state of the device
and, if necessary, contacting after-sales support and technical support.
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3：FAQ Contents 3.1：Common 3.1.22：Target not running
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3.1.22：：Target not running
After programming the firmware (program), whether the chip operates or not depends on
the settings and whether the programmed data is complete or not, please follow the flow
as below.

1：：Manual reset in online mode #

1.1：：Toolbar click on the reset button #
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1.2：：Reset button (shortcut) in the menu #

2：：Automatic reset in online mode #
If you use online full-function auto-programming, before performing full-function auto-
programming operation, please check the box: Start the target chip after programming is
completed in Signal Output Control, and then perform full-function auto-programming as
follows:



3：：Automatic reset in offline mode #
The setting of auto reset in offline mode is the same as that of auto reset in online mode:
please check the box: Start the target chip after programming is completed in Signal
Output Control.

4：：Still not working after reset #
If the program still fails to run after a reset, the problem lies in the programmed file itself,
which is roughly categorized as follows based on feedback:



• Very few manufacturers SDK compiled firmware, need to perform additional patches,
such as interrupt entry error or missing, for example, SWM181x9 series chips, different
version of the SDK compiled firmware, interrupt vector table entry is not correct, but
instead in the programming process to patch.

The marked position is the option word, which is only valid if it is 0xabcd1234; other
values may cause problems that prevent operation.

• The compiled firmware contains SRAM firmware, but when programmed, only the
flash firmware is programmed, resulting in incomplete firmware. To deal with this kind



of problem, please adjust the compilation settings (sct hash file), or consult with the
manufacturer to compile a complete flash firmware and programming it.

• Firmware contains multiple segments, when programming, only add one of the
segments, forget to add the other segments, you can merge to add the firmware,
refer to the Multi-Zone Firmware Adding Method
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3：FAQ Contents 3.1：Common 3.1.23：Unicode support
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3.1.23：：Unicode support
PowerWriter® supports Unicode accounts, Unicode installation paths.

1：：Unicode account #
supported

2：：Unicode path #
supported

3：：Promoting practices #

TIP

PowerWriter® supports full Unicode encoding, but it is recommended to keep the
default installation path or customize the installation to the ASCII path to maintain
good habits.
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3：FAQ Contents 3.1：Common 3.1.24：Canceled on operation?

Version: Next

3.1.24：：Canceled on
operation?

1：：Error message #
The following error message may appear when reading and saving data from the target
chip:
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How to read and save data on the target chip

2：：Handling #
• Wrong selection of target chip type: Check whether the target chip is connected

successfully, and when making sure that the chip is connected, pay attention to
checking whether the type of your own chip is the same as the selected chip type.

• Chip open read protection: Chip open read protection can not be read on the chip
after the operation, you can try to lift the read protection operation

The status of the read protection can be viewed before this by performing a read option
byte first operation in the menu bar:



How to remove read protection

TIP

When reading data after unprotecting the read protection, the internal memory data
will be erased automatically, so please be careful with it.
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3.1.25：：OEM mismatch

1：：OEM mismatch #
When reading, writing, loading, loading orders from applets, loading orders from Core
Workshop, etc., OEM errors, packet non-conformity, etc., may occur, all of which are
caused by inconsistencies in the settings of the original project package, the target device,
and the project file type.

2：：Handling #
After opening the project, in the upper right corner of the client software, modify the
product type to the corresponding product type to save and republish, as shown in the
following figure:
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3.1.26：：Programming
Speed
Clock speed is about 6.67Mhz (PW200/PW300/PWLINK2), 18.75Mhz (PWX1) of the
actual speed, converted to the integrated programming speed of about
400Kbps~500Kbps, 1Mbps.

TIP

• PowerWriter® is optimized at a high level of programming speed, and
PowerWriter® encrypts the data while achieving this speed.

• The programming speed will vary from chip to chip.

• In online mode, the speed is slightly lower compared to offline due to the
presence of data interaction.
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3.1.27：：Motor drive
The PowerWriter® (PW200/PW300/PWLINK2) has only a self-recovery fuse to prevent
the device from being overloaded and programmed; generally, the peak current of a
motor at startup may reach 3 to 5 times the rated operating condition of the motor, and
this current has far exceeded the trigger threshold of the device's internal self-recovery
fuse, and using the PowerWriter® to power a large load of devices may risk programming
out the device, or even the USB port or computer motherboard. At the same time, using
the PowerWriter® to supply power to large loads of equipment will risk programming the
equipment, or even the USB port or the computer motherboard. Therefore, it is
recommended to supply power to large loads separately, and isolate them if necessary, in
order to ensure the safety of each device in use.

TIP

To drive motor type applications, please use PWX1 (maximum drive current up to 3A)
for driving and connect DC power supply at the same time.
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3：FAQ Contents 3.1：Common 3.1.28：Automated machine
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3.1.28：：Automated
machine
The CTRL, OK, NG, GND, and 5V interface signals need to be connected for coordinated
programming.

• CTRL: Controls the start of low-pulse programming, which requires the input of a low-
pulse signal of >=40ms to start offline programming once.

• OK: outputs high when the programming is successful, outputs 5V, and clears the
state to low when there is a new operation.

• NG: Outputs high when the programming fails, outputs 5V, and clears the state to low
when there is a new operation.

• 5V: Machine interface power supply pin (please do not connect VREF).

• GND: Ground.

Both OK and NG output low at 0V for idle and busy states.

CTRL and key logic are the same, when starting the CTRL signal is equivalent to manually
pressing a key, the programmer enters the busy state, and the OK and NG lamps will go
out.
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TIP

• PWLINK related series products do not have automated machine programming
capabilities. If you need to use PWLINK for production, you can try to use in-line
full-featured automated programming.

• For PWX1 devices, please check the interface signals, see PWX1 Machine
Interface. (Same as PW200/PW300).
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3.1.29：：Serial port usage
Virtual serial port feature of PowerWriter®:

• Writer Functions for PowerWriter®

• General purpose serial port for debugger mode

• Can also be used directly as a regular serial port

The PowerWriter® client integrates a serial port assistant that can be accessed via the
toolbar button

The built-in serial port assistant interface is as follows
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Open the serial port assistant to use as a normal serial port tool, wiring diagram reference:



TIP

• Hardware version V1.0 does not support virtual serial ports.

• PWX1 Wiring reference PWX1 connection scheme.

• Other serial port assistant tools can be used.

Tags: FAQ Serial

Edit this page
Last updated on Apr 15, 2024 by Alan Chen

http://localhost:3000/en/docs/next/tags/faq
http://localhost:3000/en/docs/next/tags/serial
https://gitee.com/powerwriter/powerwriter-doc/tree/develop/docs/faq/powerwriter/base/029.serial.md
https://gitee.com/powerwriter/powerwriter-doc/tree/develop/docs/faq/powerwriter/base/029.serial.md


3：FAQ Contents 3.1：Common 3.1.30：PWLINK device reboot

Version: Next

3.1.30：：PWLINK device
reboot

1：：Power reset for peripherals #
Due to the hardware limitations of PWLINK itself, the output voltage is not isolated, which
may cause PWLINK to reset when powering large load peripherals directly.

2：：Handling #
Plug the PWLINK into a USB port with sufficient drive capability and use the external
device's own power supply.

TIP

PWLINK2 version: The upgraded version of PWLINK2 is isolated on the power
supply and supports 3.3V/ 5V outputs, and can also use an external reference
voltage, so there is no reset phenomenon when PWLINK is connected to a large load.
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3.1.31：：Offline package
R/W

1：：Offline loading when project is not
saved #
When loading a project offline, if the current data is not saved as a project file, you will see
the following message.

Consist of：

[Yes]: Save the project file to prevent data loss, select this option when you need to save
it.

[No]: do not save the project file, this option will generate the cache without the need
for the user to choose the save location, in order to prevent the data from being read, the
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password will use a random password.

[No longer prompt]: Do not save the project file and do not prompt this option, other
functions and [No] consistent.

2：：Adjustments to the Save and load
project #

Project Password: Project Password, will prompt for a maximum of 16 characters, can be
left blank.

Project Path: When you open a project file, you must select the project path, and when
you save the project, if you don't select the project path, the cache path will be randomly
generated.



3：：Adjustments for reading offline
project files #

If the offline project file is successfully read, you will be prompted whether to load the
project immediately to avoid overwriting the current project file and losing data.



4：：How to turn prompting back on after
choosing not to prompt again #
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3.1.32：：About Silk
When you receive the device, due to a variety of production batches, there are equipment
screen printing error printing probability, so about the pin distribution, we recommend
that you client software query to the screen print shall prevail, the inconvenience caused
to you, please forgive me! The query method is shown in the figure below:
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3.1.33：：Adapter knowledge
PowerWriter provides PW200, PW300, PWX1 adapter boards.

1：：Silkscreen and usage #
The interface of the adapter board is shown below:
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PW200/PW300 The adapter board is used as shown below:



2：：Versions Differences #
Currently there are two versions of the adapter board, the main difference is that the new
version has more 5V pins than the old version, as shown in the following figure. It should
be noted that the new version of the adapter board is suitable for 1.3 and 1.4 hardware
version of the programmer, that is, PW200 or PW300; the old version of the adapter board
is suitable for 1.2 hardware version of the programmer below. If you use the old adapter
boards for 1.3 or 1.4 hardware versions, there is a risk of shorting 5V and GND, so be
careful.

In addition, the PowerWriter® interface definition can be viewed through the
PowerWriter® software menu bar, Tools, to confirm the specific hardware version
information of the programmer.
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3.1.34：：Stuck during
installing

1：：Intend #
Download: PowerWriter® For ARM

Because some anti-virus software will be misreported driver, it is recommended that you
close 360 and other anti-virus software before installation.

2：：Stuck during installation #
When installing the PowerWriter® client, there is a low probability that it will get stuck and
not move, in fact, this time it is detected that it needs to be rebooted, and can be solved
by rebooting the system and reinstalling it.

3：：Is it mandatory #
• You may not install the software if you are only using it as a Debugger.

• For online operation of the chip, or for offline production configuration, the
PowerWriter® software is required. This tool is similar to the ST-unity tool, but with
more features, and will be expanded with more features in the future.
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3.1.35：：How to unlock the
chip
When using PowerWriter® to programming firmware, an error may be reported: Error
Write Flash Addr:The target write flash failed....

The reason for this error message may be:

• Not erased before programming (programming): Please erase the chip first and
retry.

• The chip is (write) protected: Please set the option byte to default, and then
perform a reset after writing the default option word.

• Other reasons: Occasional reasons such as unstable communication, you can try to
replace the cable and retry, if you can not identify the cause by yourself, please
contact technical support and submit detailed information for processing.

The second reason mentioned above is the need to do an unlock operation on the chip to
remove the protection.

1：：Online Unlocking Chip #

1.1：：Restore Defaults to Unlock Chip #

Switch to the option byte page, click on the right side of the restore default button, and
then click on the top of the shortcut key write, you can unlock the chip; or operation of the
menu bar in the execution of the write option byte, can be restored to the chip's option
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byte status of the factory settings, the specific page is shown below:



1.2：：Unlock Only #

If you do not want to operate the other options in addition to read protection byte, you
can double-click the option of read protection, and then click on the right side of the small
drop-down arrow, you can see all the options about the protection, and then select the
read protection off or protection off, and then write to the chip can be set up to write the
protection of the operation is the same as the specific page is shown below:



2：：Offline Batch Unlock Chip #

2.1：：Restore Defaults to Unlock Chip #

Offline programming need to remove the read protection or write protection, first switch
to the option byte page, and then click on the right side of the Restore Defaults button,
you can see that the protection is turned off, offline programming settings are complete,
click on the top of the shortcut key to load, or operation of the menu bar in the
implementation of the offline load, load the file into the programmer, and then offline
programming, you can unlock the chip in batch, the specific page is as follows As shown in
the following page:





2.2：：Unlock Only #

If you don't want to operate other option bytes except read protection, you can double-
click the option of read protection, and then click on the right side of the small drop-down
arrow, you can see all the options about the protection, and then select the protection off
or no protection, and then click on the load, for offline programming, you can batch
unlock the chip, and set up the operation of the write protection is the same as the
specific page as shown below:



CAUTION

Individual chips that differ from mainstream chips, such as HC32 or CX32, need to be
unlocked by pressing the key to turn on the ISP method once when unlocking the
chip, see the specific operation flow:

HC32 unlock; CX32 unlock.
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3.1.36：：About Project
Password
Based on the firmware delivery security considerations, we hope that many developers
focus on their own firmware security, which can be referred to from several aspects:

• Chip: Try to use better security chip products.

• Key: One of the most basic and effective ways to verify code protection,
PowerWriter® also has a variety of built-in signature mechanisms to meet the
different needs of customers.

• Platform Delivery: ICWorkshop Cloud Platform provides firmware developers with a
fast, easy-to-use and secure firmware protection and delivery model, so when
generating delivery orders, you need to provide a project password to ensure
developer rights and interests.
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1：：Project Password Setting #
When programming and packing PKG files offline, a prompt box will pop up to remind the
user to set the project password and save path, about this project password setting, in the
menu bar -> Settings -> Preferences check the box to turn on the offline read/write save
project prompt, this option will ensure that every time the project is loaded offline, the
prompt box to set the password and save path will be popped up; if it is not checked, it
will be only the first time to generate the PKG file, the If unchecked, it will only pop up a
prompt when the PKG file is generated for the first time. Users need to note that, when
remote firmware delivery is required with firmware, a password must be set when the file
is created, and users need to save the password reasonably, and when remote firmware



delivery is carried out on the cloud platform, they need to enter the correct password for
this project before uploading it successfully, or else it can't be uploaded; for the firmware
recipients, when they download the order through the platform, it is a very simple
operation without the need of password verification, and they won't see the project
information in the programmer. If the customer tries to read out the project information in
the programmer through PowerWriter® software, the password serves as the first line of
defense to protect the intellectual property rights of the developer, and no information
can be read out with a wrong password. A detailed prompt box is shown below:



The firmware password entered when uploading the platform is the same as the project
password in the picture above.





If users want to know more about encryption mechanisms, PowerWriter® has a variety of
built-in encryption mechanisms, among which ICWKEY Security Authorization Shield, as an
auxiliary tool for the offline authorization of the PowerWriter® programmer of the
PowerWriter®, provides two UIDs (Unique Chip ID) authorization algorithms, namely,
Vector Matrix Encryption (Matrix) and Elliptic Curve Digital Signature (ECDSA), and also
provides an SDK for users to develop custom authorization algorithms to meet the
different needs of developers. Unique Chip ID) authorization algorithms, but also provides
SDK for users to develop custom authorization algorithms to meet the different needs of
developers, while ensuring that the target chip + PowerWriter ® + ICWKEY the entire link
layer data security during production. ICWKEY's user manual and authorization videos are
available at the link below:

ICWKEY User Development Manual

Another technical details welcome to visit B site "about programmer authorization"
instructional video ：PowerWriter® video tutorial
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3.1.37：：Isolation adapter
usage

1：：Basic Information #
Insulation voltage：5000Vrms

Speed：150Mbps (MAX) / Debugging Clock > 10Mhz

Data latency：6.54us (typical values)

VREF Voltage Range：2.5V ~ 5.5V

Supported Devices：

✓
Power Debugger

✓
PW200

✓
PW300

✓
PW400

✓
PWX1
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2：：PowerDebugger #
Supported protocols: UART, SWJ, JTAG, wiring diagrams are referenced below:

TIP

VREF B Requires power from the target board, voltage range 2.5V to 5.5V, Power
Debugger IO voltage set to 3.3V or 5V, Serial port isolated, need to be accessed from
the green independent 4PIN.



3：：PW200/PW300 #
Supported protocols: UART, SWJ, SWIM, ITM(SWO), wiring diagrams are referenced below:

TIP

VREF B Requires power from the target board in the range of 2.5V to 5.5V, with the
PowerWriter® IO voltage set to 3.3V or 5V (no external reference can be set).



4：：PW400 #
Supported protocols: UART, JTAG, wiring diagrams are referenced below:

TIP

VREF B Requires power from the target board in the range of 2.5V to 5.5V, with the
PowerWriter® IO voltage set to 3.3V or 5V (no external reference can be set).

CAUTION

GND to L needs to be adjusted (see Change for PW400).



5：：PWX1 #
Supported protocols: UART, JTAG, SWJ, PWM, SWIM, wiring diagrams are referenced
below:

TIP

VREF B needs to be powered from the target board with a voltage range of 2.5V to
5.5V with the PowerWriter® VREF voltage set to 3.3V or 5V (no external reference
can be set).



TIP

If you need to write STM8, you should short the green resistor bit as shown (see
Short for SWIM).
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3.2.1：：Offline status
reading

INFO

PWX1 The status of the device operation results are all displayed in the screen
interface, without the need for client query.

1：：Read the results of an offline
operation #
You can reconnect to the PC software and click on the Log button to check the reason for
failure when you encounter a programming failure during offline programming:
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2：：Read device project file #
Via Menu->Execute->Read Offline and Save, or the Offline Read button on the toolbar.



3：：How to configure the number of
writer #
See Offline config

4：：How to read the remaining count #
See Query method

5：：Repeat programming occurs when
auto-programming is turned on #
Some chips open SWD multiplexing, offline programming, there is a choice to write the
option byte, or turned on the completion of programming to start the chip, or selected the
output reset, and turned on the automatic chip detection function (as shown in the figure),
may cause the possibility of repeated programming, to detect the chip as far as possible,
so that the chip is programmed in the time to be connected to the chip, will not be
mistakenly judged as taking open the chip.
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3：FAQ Contents 3.2：Standard 3.2.2：HC32 connection failure
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3.2.2：：HC32 connection
failure
The HC32 chip requires an additional processing flow when programming due to some of
the differences in the chip, as detailed below.

1：：Offline programming #
If the option byte of the chip is set to primary or secondary protection, the chip will
automatically turn off the SWD after programming, and can only be unlocked by pressing
the key to enable the ISP method once before continuing to programming, even if the
auto-programming enabled.

2：：Online programming #
To unlock the chip, you need to set the option byte to unprotected and click on write.
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3：：Setting reference #



4：：Connection Diagram Reference #
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3.2.3：：CX32 connection
failure
When burning the CX32 chip, due to some differences between the chip and the
mainstream chip, additional processing methods are required, as described below.

1：：Offline programming #
CX32 option byte is set to one level of protection or two levels of protection, the chip will
automatically turn off the SWD after programming, you can only press the button to turn
on the ISP mode once to unlock before continuing to programming, even if the automatic
programming is turned on.

2：：Online Programming #
To unlock the chip, you need to set the option byte to unprotected and click on write.
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3：：Setting reference #



4：：Connection Diagram Reference #
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3.2.4：：Remote Assistance
Since the ordinary remote function is not stable enough, and secondly, there will be
administrator privilege problem in the system above Windows 7, so it is necessary to use
the third-party professional remote analysis tool.

• The Fast Remote Desktop Application – AnyDesk

• TeamViewer – The Remote Connectivity Software

1：：Install AnyDesk #
Thank you for downloading AnyDesk
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2：：AnyDesk Usage #
Copy Your Address and send it to Customer Service.



3：：Secure Exit #
After analyzing the problem, the technician will disconnect the user and send the cause of
the error and the solution to the user. In order to minimize the disturbance or concern to
the user, it is recommended to enable automatic update verification after the remote, as
shown below:
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3：FAQ Contents 3.2：Standard 3.2.5：Handling disconnections
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3.2.5：：Handling
disconnections
If you experience, occasional failures during use, you can try the following to troubleshoot

• Attempt to reduce the communication clock speed.

• Trying to replace the cable with a better one or shorten the length of the cable
can also improve better stability.

TIP

Users in the actual product may be JTAG, SWD and other debugging interfaces
multiplexed into the product's ordinary function pins, in this case, may also lead to
abnormal protocols, for this case, it is recommended to do isolation design on the IO,
can reduce interference.
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3：FAQ Contents 3.2：Standard 3.2.6：VREF setting
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3.2.6：：VREF setting

1：：About VREF Output Jump #

CAUTION

PowerWriter® products, when starting the process of connecting the target chip, if
the connection to the target chip fails, including but not limited to no connection to
the target chip, wiring errors, can not be recognized, etc., it will try to perform a POR
(Power On Reset) power-on reset of the target chip, so the phenomenon in the
output power supply will appear, the output (VEXT, VREF) power supply Charging
and discharging behavior, there is a jump, so the purpose of processing can solve the
following similar problems:

• If some chips are protected, not executing POR may result in not being able to
connect to the target chip.

• If the debug port is disabled on some chips (including the reason of the program
of the target chip), the execution of POR can precisely control the time control
point of the connection request to ensure that it can be connected to the target
chip, so as to carry out the operation of erasing and re-programming.
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2：：Setting method #

Output power supply is optional:

• 1.8V：When 1.8V is selected, the IO signal output ports DIO/CLK, etc. are 1.8V.

• 3.3V(Default)：When 3.3V is selected, the signal output ports DIO/CLK, etc. are 3.3V.

• 5.0V: When 5.0V (5V) is selected, the signal output ports DIO/CLK, etc. are 5.0V.

• External input：When an external reference is selected, the PowerWriter® needs to
be externally supplied with a reference voltage in the range of 1.2V to 5.5V, while the
PowerWriter® still needs to be powered by USB, and the external input is only
supplied with the reference voltage.

3：：Voltage switching #
During debugging, the default output voltage is 3.3V. If you need to switch to other
voltages, please set the target voltage through the PowerWriter® software, and then start
debugging again to enter the set voltage:



TIP

In debugging mode, the system outputs 3.3V by default, if you need other voltages,
please set and apply them manually through the client software.

4：：Selection Recommendations #
Refer to the chart below:
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3：FAQ Contents 3.2：Standard 3.2.7：Bluetooth applet tutorial

Version: Next

3.2.7：：Bluetooth applet
tutorial
PW300 has a built-in Bluetooth module, which allows you to connect the burner via
Bluetooth + cell phone WeChat applet to download the firmware order to PW300 from
Gencore Workshop cloud for offline burning. ↓ In addition to firmware orders sold or
gifted by others, users can also upload firmware to Genesis Cloud Disk by themselves, and
then select the files in Genesis Cloud Disk through WeChat applet to select burning. The
specific operation process is as follows:
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1：：WeChat Scan #

2：：Device Power On #

Use the USB cable to power the device if using the PW300, or plug the USB wireless
adapter into the host USB port of the PWX1 if using the PWX1.

3：：Connected device #

When connecting the device, you need to open the Bluetooth of the phone as well as the
positioning authority in advance, and allow the applet to use the Bluetooth service, when
the Bluetooth is not opened, there will be a prompt as follows:



Select the searched PowerWriter® device, and when the programmer has a new firmware
version available for upgrade, a pop-up prompt will appear, which needs to be upgraded
via the PowerWriter® PC software. The following figure shows that two PW300 devices are
recognized, and the log message output when the PW300 device is connected.





4：：Programming Order Selection #

Order details here can be found via ICW Cloud-ICWORKSHOP For a more detailed view,
the Cloud Disk in the Files are uploaded by individuals to the program.

https://www.icworkshop.com/user/programList/




5：：Order Configuration #

When you click on the download button, you will be prompted with a pop-up window to
configure the number of programmer.



When loading a program into the programmer, a progress bar will be displayed on the top
page of the applet, and when 100% is displayed, the program has been loaded into the
PowerWriter®.



6：：Video tutorial #

Bluetooth Download Video Tutorial
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3：FAQ Contents 3.2：Standard 3.2.8：Verify chip data

Version: Next

3.2.8：：Verify chip data
1：：Connecting the programmer with target chip #
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2：：Add data to be verified, click Verify #

04/15-14:50:57:629> Power Writer® is disconnected...

04/15-14:50:58:131> Writer Info: hwVer:1.0 blVer:1.00.02

ifVer:1.00.02

SN:0123456789ABCDEF01234567890ABCDE Target:PWX1

04/15-14:50:58:147> [07D6] Current device firmware type : Universal

04/15-14:50:58:179> Power Writer® is connected...

04/15-14:50:58:194> Switch version:PWX1

04/15-14:50:58:884> Resource version:1.0.0 size:0xcc5ac crc32:0x750b0c69

04/15-14:50:58:900> Synchronizing device time succeeded...

04/15-14:50:58:950> Update burner Settings complete...



3：：Operational Demonstration #
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3：FAQ Contents 3.2：Standard 3.2.9：Nuvoton Chip Extension

Version: Next

3.2.9：：Nuvoton Chip
Extension
Since Nuvoton chips have some special features, such as M481xG with KPROM, XOM,
security secret key, etc., the PowerWriter® software puts them under Plug-in Functions,
see below:
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Corresponding to official tools



1：：KPROM Config #

1.1：：KPROM status reading #

Connecting the chip and reading the option byte allows you to get the status of the
KPROM.



1.2：：KPROM Unlock Password Setting #

When the security key protection is enabled, the LDROM and APROM are in write-
protected state, and if you want to write to them, you must enter the correct KPROM
unlock password, or report an error. When the option byte CONFIG write protection is
enabled and the option byte is to be written, an incorrect entry of the KPROM unlock
password triggers a full chip erase.



1.3：：Update KPROM password #

When you want to update the KPROM, you must check both Update KPROM and Security
Key Enable, the KPROM is written with the option byte, and clicking Write Option Byte will
operate the KPROM; the





2：：XOM Config #

2.1：：XOM status reading #

You can get the activation status of the XOM by selecting the corresponding chip model,
connecting the chip and reading the option byte:



2.2：：XOM Configuration Write #

Fill in the address to be read-protected, you must check both the enable area and the
XOM area to enable, and finally click the write option byte.





3：：Security key #

3.1：：Import of security keys #

Import the security secret key in Secure Key, the procedure can be found in: Nuvoton
NuMicro ICP Programmer User Guide.pdf.



3.2：：Configuration and write security keys #

Check BootLoader Boot and Secure Boot Encryption, then click Write Options Byte, you
can add firmware and then click Fully Automatic Programming;





4：：Secure Setting #

4.1：：Secure config #

Here we take the M2351 as an example, open Extended Settings, select Start Non-Safe
Area, write the Non-Safe Area address, and turn on the Safe Area setting in the Options
byte:

4.2：：Secure Area Unlocking Method #

After locking the setting settings, the chip will not be connected, you need to click on



Restore Defaults to write the option byte

5：：MTP Configuration #

5.1：：MTP Notes #

MTP setting belongs to the specific function of NUC505, when the burner is connected to
the chip, the PB.3 of the chip needs to be pulled down to make the chip start from the ICP
mode; after the burner is finished, the PB.4,PB.3,PA.10,PA.9 can not be pulled down for the
program to start normally.

5.2：：MTP status reading #

Connect the chip and read the option byte to get the activation status of the MTP:



5.3：：MTP Config #

Fill in the correct value in MTP Setting in Nuvoton Extended Settings, and when you need
to update MTP, you need to check both Write MTP and MTP Programming.

MTP 秘钥： 0x53215751 -0x32432356 //This is filled in randomly, with non-

all zeros and non-all ff

const uint32_t signature __attribute__((at(0x00000d00))) =

0x34333231;//The program firmware needs to be customised by setting the

signature at the offset address



Code Verification is automatically activated when the MTP is programmed.The code on the
Flash (or file to be written to SPIFlash) must pass through the Code Verification stream.The
NUC505 searches the 0 to 16 KBSPIFlash of the offset address (or file to be written to
SPIFlash) to check that the correct signature is present on the offset address (compare to
the data in the NUC505 MTP). data for comparison, see Figure 2-1). If there is no signature,
the boot or programming operation will fail. This protection mechanism is called off-chip
memory protection, so to program the encryption, it is necessary to add no less than 16K
of firmware, but not to program the encryption:



Add plaintext firmware when using programmed encryption.

When not encrypted by programming, you can read the encrypted firmware save as first,
then add it.



6：：SPI Flash encryption settings #

6.1：：SPI Flash Encryption Setting #

Select the corresponding chip, for example, M485xI, open the extended settings and
select SPI Setting, fill in the non-zero values for secret key 0 and secret key 1, and then the
chip will be encrypted and burned automatically when you are sure to burn it.
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3：FAQ Contents 3.2：Standard 3.2.10：Chip Data Export

Version: Next

3.2.10：：Chip Data Export
1：：Connecting the programmer with target chip #
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2：：Read chip data #

3：：Store to local disk #

Randomly intercept the read back data to save, right click on both ends of the data to be
intercepted to set the start address and end address, and then export the data.





4：：Operational Demonstration #

4.1：：Read the whole area #



4.2：：Reading a specific region #
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3：FAQ Contents 3.2：Standard 3.2.11：STM32WB stack upgrade

Version: Next

3.2.11：：STM32WB stack
upgrade

1：：Introduces #
PowerWriter® support for manufacturer-specific features, are using the plug-in mode, you
can support the specific features required by any manufacturer, the method of entry and
other brands of the support method is consistent, in the selection of the chip, such as in
the toolbar on the right side of the most a plug-in support icon appears, the currently
selected chip has a plug-in support function, as shown below:

After selecting the STM32WB family of chips, an Extended Functions button appears on
the right side of the toolbar, defined as Vendor Specific Plug-In Functions, which can be
clicked to enter the STM32WB Protocol Stack programming configuration page, as shown
in the figure:
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2：：Firmware Import #

2.1：：FUS Operator (Version 3.1 inside) #

FUS Operator is configured as version 3.1 on the PowerWriter® side by default. If you
need to change it to another version, please import the specified version manually, and



you will see the version number of the FUS Operator on the right side of the screen after
the import is completed.

TIP

• The FUS Operator PowerWriter® comes by default with version V3.1 with
STMWB1x, STM32WB3x, STM32WB5x versions and automatically selects the
version with the prefix 0x495 or 0x494 depending on the chip used for selection.

• FUS Operator is recommended to use the latest version, the official ST release
path is: STM32CubeProgrammer installation path\ FlashLoader\ below, such as:
C:\Program Files\STMicroelectronics\STM32Cube\ STM32CubeProgrammer\bin\
FlashLoader path.

• PowerWriter® maintains updates to the built-in FUS Operator.

2.2：：Stack firmware #

Stack refers to the protocol stack part of the firmware, the way to get the files of the
protocol stack, please refer to the official release channel of ST, it is recommended to use
STM32CUBEMX package manager to install the latest SDK, and get the latest Stack files
from the SDK installation directory, such as:

Path to get

C:\Users\CSHSOFT\STM32Cube\Repository\STM32Cube_FW_WB_V1.13.1\Projects\

STM32WB_Copro_Wireless_Binaries\

stm32wb5x_BLE_Thread_dynamic_fw.bin



Select the Stack file corresponding to the target chip to load, and refer to
Release_Notes.html , set the correct firmware address as follows:,

When completed, it resembles the following:

TIP

• The stack file has a specific format, and PowerWriter® reads the stack version
information correctly and displays it on the right.

• If the selected file is not the stack firmware, it cannot be loaded (and no error
message is reported!)

2.3：：FUS firmware（（non-essential）） #

The FUS firmware is an optional upgrade, check whether you need to upgrade the FUS
stack according to the official release. The way to get the files for the FUS stack is in the
same path as the Stack stack, it is recommended to use the STM32CUBEMX package
manager to install the latest SDK, and to get the latest FUS files from the SDK installation
directory, for example:



Path to get

Select the FUS file corresponding to the target chip to load, and refer to
Release_Notes.html to set the correct firmware address as shown below:

When completed, it resembles the following:

TIP

• FUS files have a specific format, and PowerWriter® reads the FUS version
information correctly and displays it on the right.

• If the selected file is not the FUS firmware, it cannot be loaded (and no error
message is reported!)

C:\Users\CSHSOFT\STM32Cube\Repository\STM32Cube_FW_WB_V1.13.1\Projects\

STM32WB_Copro_Wireless_Binaries\

stm32wb5x_FUS_fw.bin



3：：Online Upgrade #

3.1：：Upgrade FUS online #

After importing the FUS file designation and filling in the address correctly, the FUS stack
can be upgraded by clicking the FUS Firmware Upgrade button as shown in the figure
below, and if the upgrade is completed you will see the following result:

CAUTION

• If First install is unchecked, it will automatically delete the stack before updating
it.

• Upgrading the FUS stack may break the Stack stack, meaning that, after
upgrading the FUS stack, the Stack stack still needs to be installed.



3.2：：Upgrade Stack Online #

After importing the Stack file designation and filling in the address correctly, you can
upgrade the Stack stack by clicking the Stack Firmware Upgrade button as shown in the
following figure, and you will see the following result if the upgrade is completed:

CAUTION

• If First install is unchecked, it will automatically delete the stack before updating
it.



• Upgrading the Stack stack does not destroy the FUS stack, so upgrading the
Stack stack is placed after upgrading the FUS stack.

3.3：：Other online features #

3.3.1：：Read Infos #

You can click on this function to see the current version information and whether you are
currently running FUS or Stack, as shown below:

TIP

If there is no user firmware, it may show Not running and the version is empty.

3.3.2：：Start FUS #

You can switch to FUS stack operation by clicking on this function.

3.3.3：：Start Wireless Stack #

You can switch to Wireless Stack operation by clicking this function.

3.3.4：：Delete Firmware #

You can click this function to realize the protocol stack deletion operation.



4：：Offline programming configuration #
PowerWriter® supports offline installation (upgrade) of FUS and Stack protocol stacks.
After correctly importing FUS and Stack protocol stacks and filling in the addresses, you
can enable them in the Offline Upgrade configuration.

• Enable Stack Offline Upgrade

• Enable FUS Offline Upgrade

As shown below:

TIP

Please add the user firmware in Program Memory when you are offline.

5：：Notes #
• Upgrading the FUS, Stack, switching the operation of the stack, deleting the stack and

other operations will destroy the user firmware, so after upgrading the stack online,
you need to re-programming the user firmware. To burn the user firmware, please add
the user firmware on the Program Memory page of the PowerWriter® main page and
programming it.



• The order in which the PowerWriter® upgrades the stack when burning offline is:

◦ Upgrade FUS stack (if required)

◦ Upgrade the Stack stack , and switch to the Stack stack to run.

◦ Programming user firmware, other page data, other configuration information
such as OTP, signature information, etc.

◦ Programming user option bytes (if enabled)
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3：FAQ Contents 3.2：Standard 3.2.12：ICWorkshop Error

Version: Next

3.2.12：：ICWorkshop Error

1：：No device found #

TIP

• When burning PowerWriter® orders with ICWorkshop, the order-specified
programmer needs to be connected to the PC, and order data cannot be burned
if the programmer is not connected.

• This error occurs even though the PowerWriter® has been connected to the PC,
refer to the Common solutions to driver problems

• Contact Technical Support

2：：Please power it on again and try
again... #

"No PowerWriter® device found ..."

Failed to connect to PowerWriter®...

OS Version : >= Windows 8

Write information:

hwVer:1.1

blVer:1.00.02

ifVer:1.00.30
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TIP

The Please power it on again prompt indicates that the PowerWriter® firmware
upgrade process has not been completed, please power off and restart the
PowerWriter® and try to upgrade the firmware again. During the PowerWriter®
firmware upgrade process, there may be a framework update that requires an update
to the underlying driver, which will need to be re-energized by powering off the
system. Please follow the prompts to power off the PowerWriter® and try again to
complete the firmware upgrade.

3：：The target chip not online! #

OS Version : >= Windows 8

Write information:

hwVer:1.1

blVer:1.00.02

ifVer:1.00.36

SN:86CCD4B0C92BDF8B164AD5FE2D3981D5

Firmware is newest

Try reconnect target....

Try reconnect target....

Try reconnect target....

Try reconnect target....

Try reconnect target....

Try reconnect target....

Try reconnect target....

Try reconnect target....

Try reconnect target....

Try reconnect target....

Try reconnect target....

Try reconnect target....

Try reconnect target....

"The target not online!"



TIP

• The Target not online error indicates that the current order is written in online
mode, which requires the PowerWriter® to be connected to the target chip in
order to programming firmware data.

• To check if the target chip is properly linked to the PowerWriter® device please
refer to About Wiring .

4：：PowerWriter® project file password
error #

TIP

• When PowerWriter® project is saved as Pkg, you can choose to input user-
defined saving password or leave it blank. Pkg needs to fill in the corresponding
Pkg password when it is released through SMART Platform, if the password filled
in when the pkg project is saved is not the same as that filled in when the
SMART order is released, this error will be prompted, please refer to it:

About Project Password

OS Version : >= Windows 8

"PowerWriter® project file password error"

Failed to connect to PowerWriter®...



5：：Can't load PowerWriter® project from
... #

TIP

• Please check the OEM type of the host first, you can inquire through the
purchasing channel, or you can use the PowerWriter® client software to read the
PowerWriter® product type, such as PW200, then you need to set the project to
PW200 when packing the PowerWriter® project pkg.

• When packaging PowerWriter® project data, you need to switch the product
type to the corresponding type in the PowerWriter® software.

6：：PowerWriter® project file invalid... #

TIP

• The prompt file invalid indicates that the PowerWriter® pkg project file

OS Version : >= Windows 8

"Can't load PowerWriter® project from [PW200] to [PW300]..."

Failed to connect to PowerWriter®...

OS Version : >= Windows 8

"PowerWriter® project file invalid"

Failed to connect to PowerWriter®...



published by ICWORKSHOP is illegal, and you need to check whether the
published file format is correct and has not been tampered with.

• If the file is normal but still prompts Error size , please contact our technical
support in time...

7：：Error Write Flash Addr... #

TIP

The reason for this problem is that the target chip is offline while the order is
programming target chip, and the data can not be programming, please keep the
target chip connected when using online programming target chip.

OS Version : >= Windows 8

Write information:

hwVer:1.1

blVer:1.00.02

ifVer:1.00.36

SN:475E1B25ED3180BCA4547B58CEC24490

Firmware is newest

Try reconnect target....

Online Programing...

Online Programing checking config...

Online Programing no lisence warning...

Online Programing procssing data,this will take a long time,please be

patient ...

Online Programing erase flash data ...

Online Programing processing...

"Error Write Flash Addr: 0801D700,[[0009] The target chip is not

connected...]"



8：：timed out! #

CAUTION

• You can try to change the USB connection port, switch to another system (e.g.,
the host computer has multiple systems), and try to change to a direct
connection if you are using a USB-HUB.

• The probability of such a problem is high and cannot be solved, please contact
our technical support staff in time to give us feedback.
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3：FAQ Contents 3.2：Standard 3.2.13：Offline project reading

Version: Next

3.2.13：：Offline project
reading
See Read device project file method.
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3：FAQ Contents 3.2：Standard 3.2.14：Programming Count Set

Version: Next

3.2.14：：Programming
Count Set

1：：Configuration #
Function Configuration: Burner Setting->Programming Function Configuration->Quantity
Setting and Chip Detection->Limit the number of burning times to be turned on, and fill in
the set number of times.
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2：：Read method #
In the process of using the offline programming function, you may need to read or check
back the remaining offline programming count. Since some PowerWriter® products do
not have a screen, there is no visual display of the information, however, we provide an
auxiliary function to read the number of remaining offline programming counts, the steps
are as follows:

• Run the PowerWriter® software and connect to the programmer.

• Choose any chip.

• Execute the Read Current Page button in the toolbar on the Programmer Setup page.



Perform the above steps to read back the configuration information of the offline
production profile to see the number of offline programmer remaining.

TIP

For security: When reading offline production data configuration information, no
sensitive information will be read back, such as SN, UID signature information,
firmware data will not be read back.

INFO

PWX1 Device with screen device, the remaining number of times can be seen on the
screen.
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3：FAQ Contents 3.2：Standard 3.2.15：Remaining Count Qurey

Version: Next

3.2.15：：Remaining Count
Qurey
See How to read the remaining count.
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3：FAQ Contents 3.2：Standard 3.2.16：ICWorkshop unstarted

Version: Next

3.2.16：：ICWorkshop
unstarted

1：：Reasons for failure to start #
The client comes with a driver service, this driver service is WHQL certified, in some cases,
there may be a startup failure problem, similar to the error shown below:

2: Emergency repair methods #

2.1 Add installation directory whitelisting #

The reason for this situation is that the driver service is usually blocked, please add the
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installation directory of ChuangxinWorkshop to the whitelist, the operation procedure is as
follows:

Step 1: Locate the ICWorkshop installation directory

Step 2: Memorize the mounting location



Step 3: Add the installation directory to the whitelist of your security software and restore
driver self-boot.

2.3 Reboot after operation completed #

After completing the whitelist addition and restoring the blocked driver services, reboot
the system and log in again.

2: Notes #

TIP

If the system can normally use the client software of ICWorkshop, the above
operation can be dispensed with. The performance is not exactly the same in
different systems, different protection software, different versions and feature
libraries of the same software.
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3：FAQ Contents 3.2：Standard 3.2.17：Online Automatic

Version: Next

3.2.17：：Online Automatic

1：：Software setup #
Enter the Preferences setting from the menu in turn, and check the automatic
programming function after the chip is connected successfully, as shown below:

CAUTION
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After the chip is successfully connected, automatic reading option byte and
automatic programming can only be one or the other, the reason is that if the
automatic reading option byte is checked, it may lead to the current user's settings,
depending on the different chips, which to a certain extent will produce inconsistent
results, in order to avoid possible problems, this function is mutually exclusive.

2：：Operational Demonstration #
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3：FAQ Contents 3.2：Standard 3.2.18：ISP Support
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3.2.18：：ISP Support
The serial port of PowerWriter® can be used for ISP programming, but you need to use
specific serial port programming software, such as Flymcu to support STM32, etc. In
addition, major MCU manufacturers have provided ISP (IAP) tools, according to their own
use of the MCU model, from the official and reliable channels to obtain the serial port (ISP)
tools.

The serial port of the PowerWriter® can also be used to burn ESP32 firmware, here are the
test screenshots (vscode).
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TIP

If you encounter a chip or brand that the PowerWriter® cannot burn via ISP, please
provide prompt feedback to technical support.
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3.2.19：：IO multiplexing
If there is a multiplexing problem in the communication interface, it may not be able to
connect to the chip properly, or it may lead to an increased probability of failure, at this
time, you can use the RESET pin for assistance.

1：：Using the RESET pin #
In the chip multiplexed programming interface, generally select the chip type and connect
the chip, click on the application settings will be normally connected to the chip, if still not
connected to the reset pin, and then re-apply the settings can be normally connected to
the target chip, as shown below:

2：：Offline Mode Settings #
When burning offline with the reset pin connected, set the reset mode to Hardware Reset
Disable.
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TIP

When burning data in projects that require multiplexed programming or debugging
interfaces, you need to be aware of interference with the bus when designing the
hardware.
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3.2.20：：PowerWriter® FAQ

1：：Communications error #
Error message：：The communication port send package error

Possible causes and solutions are as follows:

• Communication is not good, we suggest to unplug the burner again, change the USB
port and restart the client.

• If the machine has antivirus software, it is recommended to close and exit and retry.

• The FLASH algorithm may be selected incorrectly, reselect the model.

• Replacing the USB port

• Try to avoid the Hub

2：：Shorted power supply #
Error message：The voltage error(abnormal power supply。

When this prompt appears, please check the circuit of the development board, there is a
short-circuit condition, disconnect the device and reconnect it after adjustment.

04/15-16:30:44:508> [0031] The voltage error (abnormal power supply)...

04/15-16:30:44:524> Target Offline...
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3：：Periodic reset #
Periodic reset phenomenon, every 4 seconds, at this time should check whether there is a
reset source, such as the presence of an external door opener dog, turn it off.

Tags: FAQ PowerWriter®

Edit this page
Last updated on Apr 15, 2024 by Alan Chen

http://localhost:3000/en/docs/next/tags/faq
http://localhost:3000/en/docs/next/tags/power-writer
https://gitee.com/powerwriter/powerwriter-doc/tree/develop/docs/faq/powerwriter/advance/020.Powerwriter_error.md
https://gitee.com/powerwriter/powerwriter-doc/tree/develop/docs/faq/powerwriter/advance/020.Powerwriter_error.md


3：FAQ Contents 3.2：Standard 3.2.22：STM32H5 Extends

Version: Next

3.2.22：：STM32H5 Extends

1：：Function Entrance #
PowerWriter® support for manufacturer-specific features, are using the plug-in mode, you
can support the specific features required by any manufacturer, the method of entry and
other brands of the support method is consistent, in the selection of the chip, such as in
the toolbar on the right side of the most a plug-in support icon appears, the currently
selected chip has a plug-in support function, as shown below:

After selecting the STM32H5 family of chips, an Extensions button appears on the right
side of the toolbar, defined as Vendor Specific Plug-In Functions, which can be clicked to
enter the STM32H5 Security Extensions screen as shown below:
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2：：Safety Function Configuration #
Click "Enable security configure" button, it will start the security configure function, the
security configure supports *.OBK file mode (STM32H56/STM32H57) and password mode
(STM32H50), the plug-in automatically selects the appropriate mode according to the
current chip, for example, selecting the chip for STM32H50 series. The plug-in
automatically selects the appropriate mode according to the current chip, such as
selecting the STM32H50 series chip. In addition to setting the password, it can export the



PASSWORD.bin file for unlocking the chip to be used in the regression.

3：：Debug authentication #
Click "Enable debug authentication(DA)" button, it will start the function of security
function regression (debug authentication of the chip, in order to analyze or unlock the
chip), the configuration of security function regression supports *.bin file mode (Trust Zone
is not turned on), and the certificate mode (Trust Zone is turned on), the password mode
regression, import bin file, certificate mode import b64 file and PEM key file, import b64
file and PEM key file. Import bin file, import b64 file and PEM key file in certificate form.

TIP

• As of now (2024/02/29) the current security features configuration and return to
support the form of password, does not support the form of certificates, the
future will be updated to support certificates, if there is an update, please pay
attention to the detailed changelog, or consult technical support and customer
service.

• STM32H50x series Only support password form, STM32H56x, STM32H57x
support both password and certificate form (currently Trust Zone is not
supported to open, please choose password form).
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3.3.1：：UID Signature

1：：About placeholders #
UID_KEYADDR_PLACEHOLEDR_EN When not masked, an overflow error is reported no
matter how the address is changed.

Treatment:

• The first method is to mask out the placeholders so that there will be no reserved
space in the program space.

• The second method is to move the signature address toward the front address of the
flash.

CAUTION

If the first method is used, masking the placeholder space for the signature data
means that the compiler's automatic checking will be skipped, and the actual
signature address that is written, must not have any data or it will be overwritten by
the signature.

2：：Verify signature #
This can be done by adding test code to the code, such as IO output signals, or by adding
a logging feature to the developer version of the firmware to output the signature results
to the log port.
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3：：Write Signature #
• In online mode: Use full-featured automatic programming.

• In offline mode: Use offline mode normally.

TIP

If you use ICWKEY for signing, you can only use offline mode.
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3.3.2：：EEPROM(OTP)
tutorials
The functions of the EEPROM and OTP pages are equivalent to a subset of Program
Memory, and the usage flow is similar to that of Program Memory.

TIP

The availability of EEPROM/OTP pages depends on the target chip.
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3.3.3：：Option Bytes Swing

1：：Option bytes swing when auto
programmed #
Very few chips have online functions that rely on the real-time status of the target chip, so
by default the chip's option bytes will be automatically read into the client when the chip
is connected. If you need to update the user-defined option bytes in the batch online
auto-programming, you can disable the function of auto-synchronization of the option
words in the setup, see below:
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3.3.4：：Super SN Tutorial

1：：Entrance #
See the menu Tools->Super Serial Number, as shown below:

2：：Supported Features #
• Supports writing serial number to any Flash block, such as Flash Memory, EEPROM,

OTP, etc.

• Big number support 1~64 (not enough can continue to increase) bytes of sequence
number writing, you can freely configure the length of the write.

• Big number supports end-of-serial number setting to avoid duplicate serial numbers
during the production process。

• Support serial number file import (xlsx table parsing, support more than 1 million
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lines).

◦ Serial number file import does not limit the length of the serial number.

◦ Serial number file import supports big number writes.

◦ Serial number file import supports writing of very long strings of serial numbers.

◦ Serial number file import supports setting the offset address, and the number of
single imports.

TIP

When importing from a file, the default is to import using the small end mode,
with the low address on the left.



3：：Big number #

Serial Number Write Address: Set the write address of the serial number, which can be
freely configured.



Serial Number Length: supports 1~64 bytes length, freely configurable.

Serial Number Starting Value (Small End Mode): Sets the starting value of the serial
number.

Step of sequence number (small end mode): Sets a single increment of the sequence
number.

Sequence Number End Value (Little Endian Mode): Sets the end value of the sequence
number.

TIP

Big number is an enhancement to Power Writer's default 4-byte serial number to
compensate for the following shortcomings of the default serial number:

• Default Serial Number Function: the length is limited to four bytes.

• Default sequence number function: no end value judgment.

• Default Serial Number Function: No arbitrary region can be set.



4：：External File Import #

External file import supports xlsx table, when importing table, you need to set the rows
and columns for serial number reading, the default is to start reading from 0 rows and 0
columns.



Test excel: PowerWriter Test Serial Number Form

5：：Notes #
• When importing from an external file, the cells must all be strings, if they are not

strings, an error will be reported.

• When importing serial numbers from external files, you need to ensure that the serial
number length is uniform.

• External serial number import defaults to the little endian.
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3.3.5：：Automatic start/stop
Some chips open SWD multiplexing, offline programming, there is a choice to write the
option byte, or turned on the completion of programming to start the chip, or selected the
output reset, and turned on the automatic chip detection function (as shown in the figure),
may cause the possibility of repeated programming, to detect the chip as far as possible,
so that the chip is programmed in the time to be connected to the chip, will not be
mistakenly judged as taking open the chip.
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3.3.6：：Variable Monitor
INFO

PowerDebugger Provides RTT Viewer, RTT Scope functions to read and write
runtime data, and recommends its use.

Currently, PowerWriter does not provide any monitoring software like J-Scope, if you need
to monitor the real-time variable data of the target chip, you can use a third party or the
monitoring tool provided by the chip manufacturer, for example, FreeMASTER provided by
NXP is a good choice, the download address of FreeMASTER is as follows:

• FreeMASTER Run-Time Debugging Tool | NXP Semiconductors

TIP

The rights to this software are owned by NXP.

1：：FreeMaster quick start #

1.1：：Project Settings #

Project -> Options to open project settings
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On the Comm Tab page, select the Plug-in module as FreeMASTER CMSIS-DAP
Communication Plug-in, as shown below:

On the Map Files Tab page, follow the flow as shown in the figure, and select the file



compiled by MDK or IAR, GCC: axf , elf, map, and so on.

After importing the file and selecting the correct format for parsing the file

CAUTION

You need to select the file with symbol signal, such as axf, elf, map, etc. The purpose
is to get the information of the symbol name, format, address, etc., which needs to
be monitored, and you can't import bin, hex, etc. After the setting is finished, you can
click View to check the information of the symbols, and if it is parsed correctly, it



means the setting is correct.

1.2：：Adding Monitoring Variables #

You can quickly create a variable watch by right clicking Create New Watched Var... in the
Variable Watch window. in the Variable Watch window, as shown in the following figure:

Setting Monitoring Properties



Change other settings as required



When finished, click OK.

1.2：：Activate #

Connect the PowerWriter to the target chip with the target chip correctly, click the Go
button on the toolbar to start the monitoring, as shown in the following figure.



You can see the real-time changing values of the variables as shown below:

TIP

FreeMASTER will not perform firmware download action, so you need to make sure
that the set symbol file and the actual running firmware are matched, otherwise it will
lead to wrong monitoring results.

2：：Notes #
For detailed tutorials on how to use FreeMASTER, please refer to the official
documentation and other related information.
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3.3.7：：NRF stack upgrade

1：：Entrance #
PowerWriter support for manufacturer-specific features, are using the plug-in mode, you
can support any manufacturer requires a specific function, the method of entry and other
brands of the support method is consistent with the selection of the chip, such as in the
toolbar on the right side of the most a plug-in support icon, the current selection of the
chip has a plug-in support function, as shown below:

After selecting the Nordic family of chips, an Extended Functions button appears on the
right side of the toolbar, defined as Vendor Specific Plug-In Functions, which can be
clicked to enter the configuration page of the NRF Protocol Stack Burn-in, as shown in the
figure:
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2：：Firmware Import #

2.1：：Modem zip package #

Download the latest modem upgrade firmware package from the official website, which is
in zip format and contains all the files required for upgrading the stack. PowerWriter
supports parsing all the information required for upgrading from the zip package without



unzipping it, and after importing it, it will automatically start parsing the zip package, and
if the parsing is successful, it will display the corresponding information in the log box, as
shown below:

-----------------------modem information-----------------------

DFU address:0x2000000c

DFU crc32:0x84fbec7c

DFU sha256 digest:72B3D7C

DFU file name:72B3D7C.ipc_dfu.signed_1.1.0.ihex

DFU file size:0x00001290

DFU version:1.1.0

[0]Modem file:firmware.update.image.segments.0.hex

[0]Modem file segment count :1

[0]Modem file digest all segment :---

->[0.0]Segment address:0x59602000

->[0.0]Segment crc32:0x8291481a

->[0.0]Segment size :0x00000918

->[0.0]Segment sha256 digest :---

[1]Modem file:firmware.update.image.segments.1.hex

[1]Modem file segment count :3

[1]Modem file digest all segment

:5A14526C47947C99DB4B69E0FE7B0959CB32281211FC1D06546223655E8AB4B1

->[1.0]Segment address:0x00006000

->[1.0]Segment crc32:0x803ecacc

->[1.0]Segment size :0x0000a000

->[1.0]Segment sha256 digest

:3E7ABC4F40119BDFA2BBF3881909832BE9404CDD7678948049AE976C670C23D9

->[1.1]Segment address:0x00050000

->[1.1]Segment crc32:0x7d083f13

->[1.1]Segment size :0x001e0000

->[1.1]Segment sha256 digest

:63FA227FEBCAAB85749F11EFB9354B44EA7933C5D55B03A86C8ED254429A138F

->[1.2]Segment address:0x0027c000

->[1.2]Segment crc32:0x98032895

->[1.2]Segment size :0x00004000

->[1.2]Segment sha256 digest



TIP

• The latest modem of Nordic NRF series chips can be downloaded from the
official website, such as NRF9160 download address is:

Compatible Downloads - nordicsemi.com。

• After importing the zip package, if the parsing fails, it will prompt the
corresponding tips, do not decompress and modify the official release of the
original zip package data, in order to prevent the information can not complete
the automatic parsing, such as parsing the time of the error, contact us in time,
with the error message tips and upgrade packages zip file.

3：：Offline Upgrade Stack Enable #
• Enable modem offline upgrade

As shown below:

TIP

PWLINK2(Lite) and other products do not support stack upgrade, but products with
offline support this function.
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3.3.8：：ZPKG usage

1：：What is zpkg? #
zpkg is the secondary package of pkg file, on the basis of pkg file, package more
information as a separate file, through this file, the developer can directly send zpkg file to
the end-user by e-mail or other means, or burn manufacturers, in addition to the
developer who packaged this file, other members will not be able to see any data in this
file, to a certain extent, you can Meet the special needs.

Although zpkg can be useful in some specific scenarios, there are some limitations that
require special attention, as summarized below.

CAUTION

• Because the file can be reloaded repeatedly: this means that the limit on the
number of times the pkg file itself will be invalidated, and if you need to control
the number of burns, you will need to control the permissions with the icwkey
device.

• Because passwords and data are packaged as a whole, which means there is a
certain risk of being attacked, PowerWriter will try its best to prevent the zpkg
file from being attacked, leading to leakage. Except for some special scenarios
where the zpkg format must be used, most common scenarios still recommend
the use of the zpkg file for security and privilege control.

• Please be strictly aware of the above defects and do not use this feature if
you are not aware of them.
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2：：How to save as zpkg? #
The method of saving a zpkg file is the same as saving a pkg file, as shown in the following
animation:

3：：How to load zpkg to Writer? #
The flow of loading zpkg file to burner and loading pkg to writer is demonstrated in the
animation below:
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3.3.9：：Adjust Default OB

1：：Usage #
PowerWriter chip adaptation process, the chip's default option bytes are adapted and
serialized for use in some scenarios, you can restore the chip's factory settings, in most
scenarios, the native default option bytes can meet the requirements, while in some
special scenarios, the default option bytes need to be adjusted to meet some of the
special application scenarios.

2：：Setting #
The method of adjusting the built-in default option byte is as follows, and the animation
demonstrates it as follows:
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3：：Reset #
Customized default option byte clearing can be performed by clicking the Restore Defaults
button, as demonstrated in the animation below:



4：：Limitations #
• Currently available in full-featured mode in online mode, disabled when software is

turned off.

• Currently valid for saving to an offline writer, invalid after reopening the project.

CAUTION

Valid only for full-featured online programming and saving to writer before the
software is closed, and will expire after reopening the project (automatically
resynchronizes default option bytes).
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